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About Client Access/400 for Windows 3.1 User Guide, SC41-3532

This book contains guide information for using Client Access/400 for Windows 3.1.

You may need to refer to other IBM books for more specific information about a partic-
ular topic. The Publications Reference provides information on all the books in the
AS/400 library.

The term PC5250 used throughout this book refers to the Personal Communications
5250 feature that is included with the Client Access/400 for Windows 3.1 product.

 Take Note!

Client Access/400 for Windows 3.1 will not work in:

WIN-OS/2, the Windows** environment in IBM Operating System/2 (OS/2)

Or

Windows NT**.

Who Should Use This Book
This book is intended for the individual who has some PC experience and needs to
perform the tasks associated with Client Access/400 for Windows 3.1.

You should be familiar with both the Disk Operating System (DOS) and Microsoft
Windows** 3.1. You must be able to do the following:

� Copy and format diskettes
� Sign on to an AS/400
� Use the AS/400 displays

This book explains how to perform tasks using Client Access/400 for Windows 3.1 func-
tions on a PC.
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Chapter 1. Welcome to Client Access/400 for Windows 3.1!

This information is provided to help you perform the tasks available in Client
Access/400 for Windows 3.1.

You can find help information for tasks in several ways, such as:

� Accessing help information by double-clicking on the Help icon in a Client
Access/400 for Windows 3.1 group window.

� Accessing help information by choosing the Help button in the Client Access/400
for Windows 3.1 dialog box.

� Selecting the options in the Help menu pull-down menu.
� Viewing the Client Access/400 for Windows Tour presentation.

AND NOW BY

� Using the information in this online user's guide

This user's guide contains information on the following tasks:

� “Installing Client Access/400 for Windows 3.1”
� “Migrating” on page 1-2
� “Starting an AS/400 Connection” on page 1-2
� Chapter 2, “Configuring and Managing”
� Chapter 3, “Accessing Databases with Client Access/400 for Windows 3.1”

 � Chapter 4, “Printing”
� Chapter 5, “File Serving”
� Chapter 6, “Sending E-Mail Using the Messaging Application Program Interface

(MAPI)”
� Chapter 7, “Using Emulators”
� Chapter 8, “Using System Object Access”
� Chapter 9, “Using the Host Command Interface”
� Chapter 10, “Coexistence Considerations”

Installing Client Access/400 for Windows 3.1
See Client Access/400 for Windows 3.1 – Getting Started for information on how to
install Client Access/400 for Windows 3.1.

Using Other Routers

The Client Access/400 for Windows 3.1 functions are written to the enhanced
advanced peer-to-peer communications (EHNAPPC) application programming inter-
face (API). Routers that support the EHNAPPC APIs should work as a replace-
ment for the router that is shipped with Client Access/400 for Windows 3.1.
However, it is the responsibility of the router provider to ensure compliance.

Related Topic
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� “Migrating” on page 1-2

 Migrating
A migration utility is provided as an alternative to purchasing installation diskettes for
Client Access/400 for Windows 3.1. You can also create installation diskettes after
Client Access/400 for Windows 3.1 is installed on a workstation. See the Migrating to
Client Access/400 for Windows 3.1 appendix in the Client Access/400 for Windows 3.1
– Getting Started manual for the detailed migration instructions. The following informa-
tion is an overview of the migration process.

Client Access/400 for Windows 3.1 is shipped in QPWXCWN (QPWXCWND for double-
byte) which is a directory in the integrated file system. The DOS with Extended
Memory client is located in the QDLS directory along with the other original clients. All
of the original clients can only access data or programs in the path below the QDLS
directory. This is the reason you cannot use the update program to migrate from DOS
with Extended Memory to Client Access/400 for Windows 3.1.

The migration process involves creating a temporary directory in QDLS then copying
the QPWXCWN directory into the temporary directory. Then a migration program is
used to preserve your current DOS with Extended Memory (running under Windows
3.1**) configuration.

Related Topic

� “Installing Client Access/400 for Windows 3.1” on page 1-1

Starting an AS/400 Connection
You must install Client Access/400 for Windows 3.1 before trying to start an AS/400
connection.

To Start an AS/400 Connection:

1. Double-click on the Client Access/400 for Windows icon.
2. Double-click on the Client Access Startup icon.
3. Enter your user ID and password when prompted.

1-2 Client Access/400 for Windows 3.1 User Guide  



Chapter 2. Configuring and Managing

This section includes topics on configuring and managing Client Access/400 for
Windows**.

Subtopics:

� “Creating Install Diskettes”
� “Creating Communications Install Diskettes” on page 2-2
� “Managing Network Drives” on page 2-3
� “Managing Virtual Printers” on page 2-6
� “Using Application Update” on page 2-9
� “Using the Client Access/400 Network Driver” on page 2-12

Creating Install Diskettes
The Administration function provides a tool for an administrator to easily create a set of
Client Access/400 for Windows 3.1 install diskettes.

Note:  You must use 1.44 MB diskettes to create the install diskettes.

To create install diskettes:

1. Double-click on the Administration icon.

The diskettes will be created from the managing AS/400 system. The default
AS/400 system is used if no managing system is specified in the configuration. To
change the managing system, select the Configuration icon from the Client
Access/400 for Windows 3.1 group window, then select the Systems icon.

Note:  The RTMS keyword in the NSD.INI file located in the WINDOWS directory
is used to specify the managing system.

2. Change the target diskette drive, if needed.

3. Select DBCS if you are creating install diskettes for double-byte character set.

4. Select the type of diskettes to create.
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5. Select OK to continue.

 Hint 

If the AS/400 has more than one language installed, a National Languages
Options window is displayed. This window allows you to select the national
language used for the install diskettes.

The Create Client Access/400 Install Diskettes window is displayed next. Select
the Diskettes Required button to see the number of diskettes needed.

6. Select the Yes radio button if you want to add a router configuration. Selecting
Yes allows you to select the type of connection and enter the system related infor-
mation into the configuration file.

7. The diskettes will be created with the minimum base function needed to make the
initial connection to the AS/400 system. The rest of the functions can be installed
from the AS/400 after the initial connection is established.

Select the Add all button to add all of the functions, or select the Add button to
choose only certain functions.

8. Select OK to create the install diskettes.

Creating Communications Install Diskettes
Install diskettes for the IBM Local Area Network Support program and the IBM TCP/IP
programs are shipped with Client Access/400 for Windows 3.1 and are located in the
QDLS file system in the QIWSTOOL folder. The diskette images are provided as an
alternative to ordering the install diskettes.

 Important! 

The LSP.DOC and TCPIP.DOC text files in the QIWSTOOL folder contain informa-
tion for using the install diskettes.

To create the LSP diskette:

1. Insert a blank formatted 1.44 MB diskette in drive A.
2. Start an AS/400 connection. See “Starting an AS/400 Connection” on page 1-2.
3. Create a network drive for the QDLS\QIWSTOOL folder. See “Creating a Network

Drive” on page 2-3.
4. Double-click on the Windows File Manager icon.
5. Double-click on the drive icon for QDLS\QIWSTOOL.
6. Select Run from the File pull-down menu.
7. Type the following in the Run box:

LOADDSKF LSP138.DSK A:

Note:  The LOADDSKF.EXE program is also located in QDLS\QIWSTOOL folder.
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To create the TCP/IP diskettes:

1. Insert a blank formatted 1.44 MB diskette in drive A.
2. Start an AS/400 connection. See “Starting an AS/400 Connection” on page 1-2.
3. Create a network drive for the QDLS\QIWSTOOL folder. See “Creating a Network

Drive.”
4. Double-click on the Windows File Manager icon.
5. Double-click on the drive icon for QDLS\QIWSTOOL.
6. Select Run from the File pull-down menu.
7. Type the following commands in the Run box one at a time. Insert a new diskette

for before selecting OK to run the next command.

LOADDSKF TCPBASE.DSK A:
LOADDSKF TCPDD1.DSK A:
LOADDSKF TCPDD2.DSK A:

Managing Network Drives
The term network drive refers to any drive that is not physically attached to your PC.
This is the same as a folder drive or a shared folder drive.

You can create network drives that become active when Client Access/400 is started by
using the Configuration icon, then selecting Shared Folders icon in the Configuration
group window. You can also create a network drive after Client Access/400 is started
by using the Folders icon.

A default is specified for caching network drives. You can change the amount of
caching used to optimize the performance for your PC when using a network drive.
See “Changing the Caching Size” on page 2-6 for information on how to change the
default caching.

Subtopics:

� “Creating a Network Drive”
� “Changing a Network Drive” on page 2-5
� “Removing a Network Drive” on page 2-5
� “Disconnecting a Network Drive” on page 2-5
� “Changing the Caching Size” on page 2-6

Creating a Network Drive
To create a network drive that is automatically connected when you start Client
Access/400:

1. Double-click on the Configuration icon in the Client Access/400 for Windows 3.1
group window.

2. Double-click on the Shared Folders icon.
3. Select the Add button.
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4. Select the arrow next to the Drive field to select the drive letter you want to assign
to the network drive. You should select a drive letter that is not currently in use.

5. Select the arrow next to the System field to select the system used.
6. Enter the name of the directory to assign to the network drive in the Folder field.

 Hint 

When you enter a folder name, only the files in the folder or in sub-directories
under the folder are associated with the drive letter. If you frequently need to
access the same folder, it may be beneficial to assign a drive letter to the
folder.

 7. Select OK.
8. Select OK again when the Shared Folders Configuration window appears.
9. Close the Client Access Configuration window.

10. Select Yes to save the configuration changes.

Note:  The drive you assign will not become available until after you restart Client
Access/400 for Windows 3.1 and will also be available each time you start
Client Access/400 for Windows 3.1

To create a network drive after Client Access/400 is started:
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1. Double-click on the Folders icon in the Client Access/400 for Windows 3.1 group
window.

2. Select the arrow next to the Device entry field to specify a drive letter that is not
being used.

3. Enter the Network Path.

The easiest way to enter the Network Path is by using the Browse button. Select
any entry in the Systems list to change the system used for the network drive.
Select any entry in Folders list to specify the directory to assign to the network
drive.

 4. Select OK.
5. Select Connect to create the network drive connection.

 6. Select Close.

Changing a Network Drive
To change a network drive in the current Client Access/400 configuration:

1. Double-click on the Configuration icon in the Client Access/400 for Windows 3.1
group window.

2. Double-click on the Shared Folders icon.
3. Select the network drive you want to change in the Current Shared Folders list.
4. Select the Change button.
5. Make the changes you want to the Drive, System, or Folders fields.

 6. Select OK.
7. Select OK again when the Shared Folders Configuration window appears.
8. Close the Client Access Configuration window.
9. Select Yes to save the configuration changes.

Removing a Network Drive
To remove a network drive in the current Client Access/400 configuration:

1. Double-click on the Configuration icon.
2. Double-click on the Shared Folders icon.
3. Select the network drive you want to remove in the Current Shared Folders list.
4. Select the Remove button.
5. Select OK to remove the network drive.
6. Select OK again when the Shared Folders Configuration window appears.
7. Close the Client Access Configuration window.
8. Select Yes to save the configuration changes.

Disconnecting a Network Drive
To disconnect a network drive:

1. Double-click on the Folders icon.
2. Select the network drive you want to disconnect in the Current Connections list.
3. Select the Disconnect button.

 4. Select Close.
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Changing the Caching Size
Client Access/400 uses the extended memory in your PC for caching network drives.
The default amount used is 320 KB. You can specify from 3 KB to 8192 KB for the
amount of extended memory to reserve for caching. Specify 0 if you do not want to
use caching.

If you need more memory for other applications, you may want to specify 0 for no
caching or reduce the amount of memory reserved for caching.

Note:  Specifying a value for the cache provides a faster access time when using a
network drive.

To change the caching:

1. Double-click on the Configuration icon.
2. Double-click on the Shared Folders icon.
3. Select the Advanced options button.
4. Enter the amount of memory in KB (kilobytes, number x 1024) to reserve for

caching. Select the Default button to change the caching back to the default
setting.

 5. Select OK.
6. Select OK again when the Shared Folders Configuration window appears.
7. Close the Client Access Configuration window.
8. Select Yes to save the configuration changes.

Note:  Any change to caching will not be effective until the next time you start Client
Access/400 for Windows 3.1.

Managing Virtual Printers
The virtual printer function of Client Access/400 lets you use printers attached to the
AS/400 system as though they were directly attached to your PC. To use a printer
physically attached to the AS/400, you need to assign it as a virtual printer connected
to a printer port on your PC. This allows you to print to the AS/400 printer as though it
were physically attached to your PC.
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You can configure Client Access/400 to automatically assign a virtual printer when you
start Client Access/400. You can also assign or release a virtual printer after Client
Access/400 is started.

 Hint 

To use a PC printer connected to another PC that is connected to the AS/400, see
“Sharing a PC Printer” on page 2-9.

Subtopics:

� “Adding a Virtual Printer”
� “Removing a Virtual Printer” on page 2-8
� “Assigning a Virtual Printer” on page 2-8
� “Releasing a Virtual Printer” on page 2-9
� “Sharing a PC Printer” on page 2-9

Adding a Virtual Printer
To add a virtual printer to the Client Access/400 configuration:

Note:  See the online help if you need more information when using the following steps
to configure a virtual printer.

1. Double-click on the Configuration icon in the Client Access/400 for Windows 3.1
group window.

2. Double-click on the Virtual Printers icon.

3. Select the Add button.
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4. Use the down arrows to select the Local Device Name (LPTn: printer port) and
System Name. Use an LPT port that is not currently being used.

5. Select a Printer Device or a Printer File, or both by using the check boxes. Then
enter the name of the printer, printer file name, and printer file library where appro-
priate.

6. Select the Advanced options button to change the printer page format or printer
setup options.

7. Select OK for the Add Printer Definition window.
8. Select OK for the Virtual Printer Configuration window.
9. Close the Client Access Configuration window.

10. Select Yes to save the configuration changes.

Note:  Any virtual printers that are added will become available the next time you start
Client Access/400.

Removing a Virtual Printer
To remove a virtual printer from the configuration:

1. Double-click on the Configuration icon.
2. Double-click on the Virtual Printers icon.
3. Select the printer to remove.
4. Select the Remove button.
5. Select Yes to confirm removing the printer.
6. Select OK for the Virtual Printer Configuration window.
7. Close the Client Access Configuration window.
8. Select Yes to save the configuration changes.

Assigning a Virtual Printer
To assign a virtual printer when Client Access/400 is running:

1. Double-click on the Virtual Printers icon in the Client Access/400 for Windows 3.1
group window.

2. Use the down arrow to select a LPTn (printer port) that is not already in use to
assign to the printer.

3. Select the Browse button to bring up the Browse Network Printers window.
4. Use the down arrow to select the name of the system with the printer.
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5. Use the down arrows to select a printer device, printer file library, and printer file.
For field specific information, select the Help button.

6. Select OK on the Browse Network Printers window.
7. Select the Connect button.
8. If you want to change the page format, select the Format button. If you want to

change the printer setup, use the down arrow to select the printer data type.
Select the More options button for additional printer setup options.

9. Select OK to assign the virtual printer.
10. Select Close.

Releasing a Virtual Printer
To disconnect (release) a virtual printer:

1. Double-click on the Virtual Printer icon in the Client Access/400 for Windows 3.1
group window.

2. Select the printer to disconnect from the current connections list of printers.
3. Select the Disconnect button.

 4. Select Close.

Sharing a PC Printer
A printer attached to one PC can be shared with other PCs attached to the AS/400.

To share a printer:

1. Create a RUMBA/400 or PC5250 printer session on the PC that has the attached
printer. Use the RUMBA/400 Device Name field or the PC5250 Workstation ID
field to assign a name to the printer.

2. For every other PC, create a virtual printer using the name assigned to the printer
session in step 1.

Related Topics:

� “Creating a Printer Session” on page 7-2 (RUMBA/400)
� “Creating a Printer Session” on page 7-3 (PC5250)
� “Adding a Virtual Printer” on page 2-7

Using Application Update
The application update function of Client Access/400 lets you update Client Access/400
programs stored on the PC with newer or older versions of the same programs stored
on the AS/400.

The files on the PC are compared to the files on the AS/400. If the files are different,
the update function copies the files from the AS/400 down to the PC.

Subtopics:

� “Configuring Update” on page 2-10
� “Running Update” on page 2-10

  Chapter 2. Configuring and Managing 2-9



 Configuring Update
To configure update:

1. Double-click on the Configuration icon in the Client Access/400 for Windows 3.1
group window.

2. Double-click on the Application Update icon.

The Applications to Update box displays a list of the PC applications currently
being updated through the Client Access/400 for Windows 3.1 update function.

3. Select the Add, Change, or Remove button to make changes to the configuration.
 4. Select OK.

5. Select Yes to save the configuration changes.

 Running Update
To run update after Client Access/400 is started:

1. Double-click on the Application Update icon in the Client Access/400 for Windows
3.1 group window.

2. Select the application to update either by clicking on the name in the window list,
or by using the Select all button to select all of the applications in the window list.

3. Select the Update now button to start the update.
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Analyze button

Select the Analyze button to determine how many files are to be updated for the
selected applications. The amount of space required is also determined. The results
are displayed in the Drive Space Analysis box.

Note:  If you have a slow connection, for example SDLC or asynchronous, it not
recommended to use the Analyze button because of the amount of time it will
take. Also, if you have a limited amount of harddisk space available, you want
to update each entry one at a time.

Force update

Selecting Force update compares all files does an analysis of the files. Only the files
needing to be updated will be updated. For example, if you had 20 files on your PC
when the analysis is performed and only 4 of the files have changed, only those 4 files
will be updated.

Note:  Updating only the files that are changed is the normal behavior for the update
function.

The following check boxes show how update is currently configured. Although these
check boxes are present on the Client Access/400 Update window, you cannot directly
change them. If you click on the check box, a pop-up window allows you to exit update
and start the configuration program to make the changes.

One-pass mode
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Selecting this check box allows the update to be done in one step without copying the
files into a temporary directory. The PC is updated by replacing or deleting files in the
target directory.

Note:  There are some applications like Client Access/400 for Windows 3.1 that can
only be updated in two phases; and therefore, cannot use the one-pass mode.
In phase 1, the update function puts the updated files in a temporary directory
because the files in the update target may be in use. In phase 2, the update
function moves the files from the temporary directory to the target directory and
then restarts Windows.

Update subdirectories

Selecting this check box allows subdirectories below the target directory to be updated.
For example, assume that the source directory MASTDIR contains a subdirectory called
DATFILES where the application data files are located. If the target directory
YOURDIR on your PC also has a DATFILES subdirectory, selecting the Update subdi-
rectories check box ensures that updates are also made to the files in the subdirectory
DATFILES on your PC.

Note:  This option is only available if the File Driven check box is selected.

Package driven

Selecting this check box causes the update function to use package files (*.PKG) to
determine if the application needs to be updated. This is the fastest update method.
All Client Access/400 applications are set up to use package files.

File driven

Selecting this check box causes update to compare each file on the source and target
directories to determine if an application needs to be updated.

This method takes longer than the package-driven method. Also, this method must be
used if your application is not using a package (*.PKG) file.

Using the Client Access/400 Network Driver
The Client Access/400 for Windows 3.1 network driver allows you to assign AS/400 or
other network resources from the Windows File Manager, Print Manager, and Control
Panel. After the network driver is installed, a Network icon is added to the Windows
Control Panel. The Network icon allows you to view the current network connections.

Note:  The Windows Control Panel is accessed by double-clicking on the Main icon in
the Program Manager window, then double-clicking on the Control Panel icon.

Subtopics:

� “Installing or Removing the Network Driver” on page 2-13
� “Configuring the Network Driver” on page 2-13
� “Using File Manager with the Network Driver” on page 2-13
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� “Using Print Manager with the Network Driver” on page 2-14
� “Attaching to More Than One Network” on page 2-15

Installing or Removing the Network Driver
To install or remove the network driver:

1. Click on the Setup icon on the Client Access/400 group window.
2. Click on the Network icon.
3. Click on the Install or Remove button.

 Driver Installation

� Only one driver can be installed under Microsoft Windows. If you have already
installed a network driver, selecting this option will disconnect the current
network driver installed on your PC and install the Client Access/400 network
driver. The Current network driver installed  prompt shows you the
description of the current network driver, if one is installed.

� See “Attaching to More Than One Network” on page 2-15 for information on
deciding which driver to install when more than one driver is available.

The following changes are made to the SYSTEM.INI file in the Windows directory:

 

[boot]
network.drv=C:\CAWIN\EHNWNNET.DRV

[boot.description]
network.drv=IBM AS/4ðð Network

Configuring the Network Driver
The network driver does not require any additional configuration, but you can select
whether or not you want the Client Access/400 network driver to display error mes-
sages.

To stop the network driver from displaying error messages:

1. Click on the Control Panel icon on the Windows Main group window.
2. Click on the Network icon.
3. Click on the Disable warning check box.

Using File Manager with the Network Driver
After the Client Access/400 network driver is installed, you can use the Windows File
Manager to configure network connections.

To configure a new network connection:

1. Select the Network Connections option from the Disk pull-down menu on the
Windows File Manager window.

2. Select the Browse button.
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All currently active system connections are shown in the Systems list window.

3. Locate the file system or directory you want to assign as a network connection:

� Double-click on an entry in the Systems list window to display the file systems
available on the AS/400.

� Double-click on an entry in the Folders list window to display any directories
under the Folder entry.

4. Select OK to add the network connection.

5. Select Close when you are finished.

Using Print Manager with the Network Driver
After the Client Access/400 for Windows 3.1 network driver is installed you can select
View and Options from the Windows Print Manager window to perform tasks associated
with network printers.

View Pull-down Menu

The Selected Net Queue item shows a detailed list of all the documents sent to the
selected network printer. The Other Net Queue item displays a list of documents sent
to a network printer that you are not connected to. These options provide a way to
view which spooled files are in an AS/400 output queue.

Notes:

1. For another way to view and manage AS/400 spooled files from the PC see
“Printer Output” on page 8-2.

2. These options require Client Access/400 for Windows 3.1 data queues to be
loaded.

Options Pull-down Menu

Selecting Network Settings opens the Network Options dialog box. The Network
Options dialog box allows you to specify what information about a network printer is
displayed on the Print Manager window. Selecting Network Connections allows you
connect and disconnect printers using the Print Manager interface.

Notes:

1. Selecting the Update Network Display check box decreases performance on both
the PC and the AS/400. This is because the network driver polls the AS/400 for
printer status. Polling only occurs when the Print Manager window is maximized.
Also, having many spooled files in the specified output queue causes a decrease in
performance.

2. Selecting the Print Net Jobs Direct check box allows you to specify whether you
want to print directly to the network and bypass Print Manager. Printing directly is
generally faster than printing with Print Manager because Print Manager tracks all
documents as if they were sent to a local printer.
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Attaching to More Than One Network
Windows allows only one network driver installed at any one time, although several net-
works can be active at the same time. If your workstation is attached only to AS/400s
and does not use LAN Server/400, you should use the Client Access/400 for Windows
3.1 network driver.

Before deciding which network driver to install, you should determine which network
you use more often in terms of assigning and releasing network resources. You should
also consider the level of functions provided by the driver. You can change from one
network driver to another, but it requires you to restart Windows after each change.

The Client Access/400 for Windows 3.1 network driver is written to handle any network
which supports the standard DOS redirection interface. This allows the Client
Access/400 for Windows 3.1 network driver to assign and release printers and drives
for other networks that also support the standard DOS redirection interface, such as,
Novell NetWare, Microsoft Windows, and the DOS LAN Requestor.

Some products, such as, DOS LAN Services 4.0 have less function if their own network
driver is not installed. Also, some products such as, Windows for Workgroups** will not
work without their driver installed.

Hint for Network Drives and Virtual Printers

If you are not using the Client Access/400 for Windows 3.1 network driver, you can
still use the Folders and Virtual Printer functions to assign and release network
drives and virtual printers.
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Chapter 3. Accessing Databases with Client Access/400 for
Windows 3.1

This section discusses several ways to access databases using Windows 3.1. Covered
are:

� “Transferring Data Using File Transfer”
� “Transferring Files Using RUMBA/400”
� “Using ODBC” on page 3-2
� “Working with Multimember Files” on page 3-8

Transferring Data Using File Transfer
Client Access/400 for Windows 3.1 allows you to transfer data from the AS/400 to your
PC, or from your PC to the AS/400. After you have established a connection to your
AS/400, you can start a transfer function by either:

� Double-clicking on the File Transfer icon in the Client Access/400 for Windows 3.1
group windows.

� Choosing Transfer in either of the 5250 emulators: PC5250 or RUMBA/400.
� Double-clicking on a saved RUMBA/400 file transfer profile in File Manager or in a

program group.

Subtopics:

� “Transferring Files Using RUMBA/400”

Transferring Files Using RUMBA/400
Following are the steps for transferring files from the AS/400 to your PC using
RUMBA/400:

1. Double-click on the Data Transfer icon from the Windows program group.
2. Select the Set Transfer button in the RUMBA/400 Data Transfer window to specify

the transfer from the AS/400 to the PC. You can also specify the direction of the
transfer by choosing the Arrow button.
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3. Select the Request AS/400 library list button.
4. Select the AS/400 library to display a list of files.
5. Select the file and member.
6. Select the drive containing the directory that you are going to transfer the files to.
7. Select the directory that your are going to transfer the files to.
8. Type the name of the file to use in the File Name text box.
9. Select the Run file transfer button from the tool bar.

 Hints 

� You can delay the transfer of a file by selecting the Timed Transfer button on
the tool bar.

� You can transfer more than one file at a time by using the Batch Transfer
button.

 Using ODBC
Microsoft Open Database Connectivity (ODBC) is an industry-standard interface defined
by the Microsoft Corporation for database connectivity. ODBC provides a layer
between a client application and a database that enables any application that is ODBC
enabled to access data from any database.

ODBC uses some terms that you may not be familiar with. The following is a list of
some of those terms and the equivalent for the AS/400:

qualifier SQL Relational Database (RDB) name (generally the system name)

owner library or SQL collection

table physical file of SQL table

view logical file of SQL file

There are several steps that you need to follow to use the ODBC driver. You need to
install the driver, create a data source, and connect to the data source. Those steps
are described next.

Subtopics:

� “Installing the ODBC Driver”
� “Setting up a Data Source” on page 3-3
� “Connecting to a Data Source” on page 3-8
� “Working with Multimember Files” on page 3-8
� “Application Setup Tips” on page 3-8

Installing the ODBC Driver
The Client Access/400 install process provides an option for installing the Client
Access/400 ODBC driver. If you chose to install this option, the driver is installed and
an icon is placed in the Client Access/400 for Windows group labeled ODBC Driver.
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To install the ODBC driver after the initial installation of Client Access/400 for Windows
3.1, double-click on the Setup icon in the Client Access/400 for Windows program
group. Then select the ODBC driver from the list box.

Important ODBC Version Information

V3R1M1 of Client Access/400 for Windows client includes an ODBC driver that sup-
ports Version 2.0 of the Microsoft ODBC specification. In order to support Version 2 of
ODBC some new components from Microsoft must be installed in your \WINDOWS and
\WINDOWS\SYSTEM directories. If you do not already have these files installed on
your system from some other source then you should install them using the copy
instructions that follow.

Note:  The Microsoft ODBC files shipped with CA/400 for Windows are the English
language versions. If you have already installed these Version 2 programs for
your national language then you may not want to replace them with the English
language versions.

These files include:

ODBC.DLL - The ODBC Driver Manager
ODBCINST.DLL - The ODBC Driver installer DLL
ODBCINST.HLP - The ODBC Driver Installer/Administrator help file
ODBCADM.EXE - The ODBC Administrator program

The following directions assume you have a shared folder assigned as drive I: and that
Windows is installed in the \WINDOWS directory of the current drive.

For a single-byte system use the following commands:

 COPY I:\QPWXCWN\ODBCADM.EXE \WINDOWS
 COPY I:\QPWXCWN\ODBC.DLL \WINDOWS\SYSTEM

COPY I:\QPWXCWN\ODBCINST.DLL \WINDOWS\SYSTEM
COPY I:\QPWXCWN\ODBCINST.HLP \WINDOWS\SYSTEM

For a double-byte Japanese system use the following commands:

 COPY I:\QPWXCWND\JDBCADM.EXE \WINDOWS\ODBCADM.EXE
 COPY I:\QPWXCWND\JDBC.DLL \WINDOWS\SYSTEM\ODBC.DLL

COPY I:\QPWXCWND\JDBCINST.DLL \WINDOWS\SYSTEM\ODBCINST.DLL
COPY I:\QPWXCWND\JDBCINST.HLP \WINDOWS\SYSTEM\ODBCINST.HLP

For a double-byte non-Japanese system use the following commands:

 COPY I:\QPWXCWND\ODBCADM.EXE \WINDOWS
 COPY I:\QPWXCWND\ODBC.DLL \WINDOWS\SYSTEM

COPY I:\QPWXCWND\ODBCINST.DLL \WINDOWS\SYSTEM
COPY I:\QPWXCWND\ODBCINST.HLP \WINDOWS\SYSTEM

Setting up a Data Source
Before you can use the ODBC driver to access the AS/400 database, you need set up
a data source.

To set up a data source:
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1. Double-click on the ODBC Driver icon in the Client Access/400 for Windows 3.1
group window. The Data Sources window is displayed.

2. Press the Add button, select the Client Access/400 for Windows 3.1 ODBC Driver
from the Installed ODBC Drivers list box, and then select OK.

3. The next screen you will see is the Client Access/400 ODBC Driver Setup screen.
From this screen you can define a data source that you can later attach to ODBC
compliant applications.

Data Source Name Enter a descriptive name for the data source.

Description This entry always defaults to Client Access/400 ODBC
driver.

System This entry identifies the AS/400 system where the data is
located. Use the down arrow to select a system from a
list of systems that are currently connected.

User ID This is your AS/400 system user ID. This entry is
optional.

Commit Mode This entry is used to set up the appropriate level of com-
mitment control for your application and environment. The
default setting is 0,*NONE. This means that all trans-
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actions are immediately committed and are not eligible for
rollback.

Default Libraries This entry is used to tell the system which libraries to use
with this data source.

The libraries in the list box can either be added to the the
users's library list or replace the list entirely. To replace
the list specify a list of library names. To add to the
existing user library list you need to add a special entry,
*USRLIBL, to the list of of libraries. All libraries listed
before *USRLIBL are added to the front of the library list.
All libraries listed after *USRLIBL are added to the end of
the library list.

The first library in the list is used as the default collection.
If you do not want a default collection, start the list with a
comma.

For example:

LIB1 LIB2 LIB3 replaces the server job's library list
with the three libraries specified. The default col-
lection is LIB1.

LIB1, *USRLIBL, LIB2 adds LIB1 to the front of the
server job's library list and adds LIB2 to the end of the
list. The default collection is LIB1.

4. Select the Options button to set the format, performance, and miscellaneous
options. Each of the radio buttons controls a specific set of options which are
listed to the left of the radio buttons. Use the down arrow to show the values for
each of the options.

 

Format Options

� The naming convention option tells the driver to use SQL or system naming
conventions. If you use SQL naming conventions all names must be passed
to the AS/400 as LIBRARY.FILENAME. If you use system naming con-
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ventions all names must be passed to the AS/400 as LIBRARY/FILENAME.
Since a large number of PC applications use periods (.) as part of their naming
conventions, the default value is SQL naming.

� The date format defaults to yyy-mm-dd.
� The date separator defaults to a dash (-).
� The time format defaults to hh:mm:SS.
� The time separator defaults to a colon (:).
� The decimal format defaults to a period (.).

 

Performance Options

� The first entry lets you enable or disable Extended Dynamic Support. 0 disa-
bles package support and 1 enables package support for using SQL package
support with the ODBC driver. The default is 1 (enabled). When package
support is enabled for the current application, statements that are prepared are
stored in a SQL package on the AS/400. The next time the application needs
to prepare and run the statement, the prepared statement in the package is
run. This enhances performance if the same statements are used often.

See “Setting up Packaging Support for an Application” on page 3-9.

� The second entry defines the type of record blocking used when data is
retrieved. This option allows you to control the conditions used by the driver to
retrieve multiple rows of data from the AS/400.

0 Record blocking disabled.
1 Record blocking enabled only for SELECT statements ending with an

explicit "FOR FETCH ONLY" clause.
2 Record blocking enable for everything except SELECT statements con-

taining an explicit "FOR UPDATE OF" clause.

� The third entry is used to define the size of the record block used when record
blocking is enabled. This entry allows you to control the size of the block of
rows retrieved from the AS/400. The value is specified in kilobytes (1 KB =
1024 bytes). The block size is divided by the size of one row of data to deter-
mine the number of rows to retrieve in one request. 1 KB is the smallest block
available and 512 KB is the largest block available. The default is 32 KB.
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� The fourth entry is used to enable or disable the lazy close feature. The lazy
close feature allows you to control the way that SQLFreeStmt with the
SQL_Close option are handled by the ODBC driver. If lazy close is enabled,
an SQLFreeStmt with the SQLClose option is not sent to the AS/400 until the
next request is sent. If lazy close is disabled, an SQLFreeStmt with the
SQLClose option causes an explicit flow to the AS/400 to close the statement.

The default is 1 (enabled). This reduces flows to the AS/400 and improves
performance.

� The fifth entry is used to define the way you see the AS/400 during certain
catalog functions. When LibraryView is set to 0, only the libraries specified in
the default library list are returned. If the LibraryView is set to 1, all of the
libraries in the system are retured. The default is 0. If you set the LibraryView
to 1, there will be some decrease in performance due to the potential volume
of files and libraries to process.

 

Miscellaneous Options

� The first entry is used to enable or disable translation of data stored in CCSID
65535 or HEX. This allows you to control the way that the ODBC driver
handles columns found on the AS/400 with an explicit CCSID of 65535. The
default is 0.

0 Do not translate the data to ASCII. Treat the data as bit data.
1 Translate the data to ASCII.

� The second entry defines whether the SQL descriptions are of an object or the
AS/400 descriptions. This allows you to control the value returned for the
REMARKS column for the ODBC catalog APIs (SQLTables, SQLColumns, ...).
The default is 0.

0 Return the description of the object that is set by OS/400*
1 Return the comment of the object that is set by SQL/400*. This is only

available for SQL collections.

� The third entry defines if the cursor can be scrolled if the cursor points at only
one row of data. Some PC applications make calls to cursors expecting them
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to be scrollable. If the cursor has only one record, the AS/400 normally treats
this cursor as non-scrollable. This option forces cursors with a rowset of 1 to
be scrollable. The default is 0.

0 Force cursors with only one record to be scrollable.
1 Do not force cursors with only one record to be scrollable.

5. When all options are set, select OK to save the data source name and return to
the Data Sources screen.

6. Select the Close button to exit the ODBC driver setup.

You have now defined a data source that can be used by any ODBC-compliant
Windows application.

Connecting to a Data Source
Once you have created an ODBC data source, you can access AS/400 data by using
the Client Access/400 for Windows 3.1 Database Access.

Note:  You cannot change the AS/400 data because Database Access is a read-only
facility.

Using Database Access you can define queries that select and retrieve data from the
AS/400. To do this, use the following steps:

1. Make sure you have an active link to the AS/400 by selecting the AS/400 Con-
nection icon.

2. Select the Database Access icon.

3. Select an existing data source and choose the OK button. The message at the
bottom of the window tells you when the connection is complete.

Working with Multimember Files
The Client Access/400 for Windows 3.1 ODBC driver does not directly support working
with multimember files on the AS/400. However, you can access members other than
the first member of a multimember file by using the Override with Database File
(OVRDBF) command in an SQL statement.

The following SQL statement could be run from an ODBC application so that referring
to file USER can access member COMPANY instead of the first member in file USER.
The 65 is the number of characters (including spaces) between the single quotes.

CALL QSYS.QCMDEXC('OVRDBF FILE(USER)
 TOFILE(LIB/USER)
 MBR(COMPANY)
 OVRSCOPE(\JOB)'
 ðððððððð65.ððððð)

Application Setup Tips
This section describes how to set up many of the current best-selling Windows applica-
tions to use the Client Access/400 for Windows 3.1 ODBC driver. In many cases,
applications supporting ODBC work without additional configuration for the Client
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Access/400 for Windows 3.1 ODBC driver. The following is a list of application config-
uration tips that have been tested with the ODBC driver.

General Information

Most ODBC applications use the form owner.name to specify a table in an SQL state-
ment. Some applications use the form qualifier.owner.name to specify a table in an
SQL statement. The qualifier portion of the name is the relational database (RDB)
name as retrieved from the AS/400. The AS/400 has a default value for the RDB name
that is used if the RDB name has not been set.

If you are using an application that specifies the qualifier in SQL statements then you
must set the RDB name to a meaningful name (typically the system name) using the
OS/400 ADDRDBDIRE command. Lotus Approach** and Crystal Reports** are two
applications that require you to set the RDB name.

Subtopics:

� “Setting up Packaging Support for an Application”
� “Brio DataPrism” on page 3-12
� “Client Access/400 Database Access” on page 3-12
� “Computer Associates Visual Express” on page 3-12
� “Crystal Reports for Visual Basic” on page 3-12
� “Lotus Approach” on page 3-12
� “Lotus 1-2-3” on page 3-12
� “Microsoft Access” on page 3-13
� “Microsoft Excel/Query” on page 3-13
� “Microsoft Visual BASIC” on page 3-13
� “Powersoft Products” on page 3-13
� “ShowCase Vista” on page 3-14

Setting up Packaging Support for an Application
Extended dynamic support provides a means to cache dynamic SQL statements on the
AS/400 server. With extended dynamic, information about the SQL statement is saved
away in an SQL package object on the AS/400 server the first time the statement is
run. On subsequent uses of the statement, the ODBC driver recognizes that the state-
ment has been run before and can skip a significant part of the processing by using the
information saved in the SQL package. Statements which are cached include SELECT,
positioned UPDATE and DELETE, INSERT with subselect, DECLARE PROCEDURE,
and all other statements which contain parameter markers.

Extend dynamic support is enabled through the addition of keywords and values to the
ODBC.INI file. These keywords can be added by an administrator or they will be added
by the ODBC driver when an application is first used. All extended dynamic support is
application based. This means each application can have its own configuration for
extended dynamic support.

Extended dynamic support is controlled through the use of the ExtendedDynamic
keyword. If the value for this keyword is 0, no packages are used and no additional
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information is added to the ODBC.INI file. If the value is 1, the following keywords and
values are added to the ODBC.INI file.

When an application is run for the first time, the ODBC driver adds a line to the
ODBC.INI file for the datasource in use that looks like the following:

Package<Appname> = lib/packagename,usage,pkg full option,
pkg not used option

Note:  The indented line is actually an extension to the right of the line directly above
it.

Once this entry is added to the ODBC.INI file, it can be changed to provide the support
that you want.

 

Package <Appname >

The Package portion of this value is always present. The Appname portion is taken
from the application. Each application is given a name when it is created. The name is
unique for each application. The ODBC driver extracts the name from the application
and uses it to build this keyword.

The name is not externalized in any way through Windows so it is difficult for an admin-
istrator to know the name to configure the ODBC.INI file. The application should be run
once to allow ODBC to determine the name and add it to the ODBC.INI file.

 

lib/packagename

This value specifies the name of the package used to store the SQL statements. By
default the package is stored in library QGPL and the name is derived from the applica-
tion name described above. All 10 characters of the package name are placed in the
ODBC.INI file entry. The last three characters of the package name are derived from
the values specified for the CommitMode, Naming, Decimal, DateFormat,
DateSeparator, TimeFormat, and TimeSeparator keywords in the same datasource
entry. These characters are shown enclosed in parenthesis to signify that they should
not be changed.

 

usage

0 The ODBC driver does not use a package when running this application.

1 The ODBC driver uses the package specified it exists but does not add any other
statements to the package or create the package if it does not exist. This is the
default value.
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2 The ODBC driver uses the package specified and adds statements to the
package as they are run. If the package does not exist when a statement is
being added, the package is created on the server. The preset values (commit-
ment control, naming, and so forth) are set to the current values in the ODBC.INI
file.

 

package full option

0 If the package becomes full, no further statements are added to the package and
the original statements remain in the package. Each new statement is run
without the benefit of being stored in the package. This is the default value.

1 If enough statements are added to the package so that it becomes full, the
package is cleared of all statements. New statements can then be added. Pack-
ages can store up to 512 statements.

 

package not used option

This value is used to tell the ODBC driver what to do when it is determined that the
configured package cannot be used. This determination is made on the first call to
SQLPrepare or SQLExecuteDirect API calls which try to use the package. Situations
where the package for the application cannot be used include:

� The default SQL collection in the ODBC.INI file does not match that with which the
package was created.

� The job CCSID does not match the job CCSID under which the package was
created.

0 The ODBC driver returns an error to the caller on the first statement prepare or
execute direct.

1 The ODBC driver establishes the connection and returns a warning to the caller
on the first statement prepare or execute direct. This is the default value.

2 The ODBC driver returns no indication that the package is not being used.

 

Considerations for using package support

If an application has a fixed number of SQL statements in it, it is recommended that a
single package be used by all users. An administrator should create the package and
run the application to add the statements from the application to the package. Once
that is done, configure all users of the package to not add any further statements but to
just use the package.
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Multiple users can add to or use a given package at the same time. Keep in mind that
as a statement is added to the package, the package is locked. This could cause con-
tention between users and reduce the benefits of using the extended dynamic support.

If the application being used has statements that are created by the user and are
random in nature, it is recommended that each user have their own package. Each
user can be configured to add statements to their private package. For each user to
have a private package, he ODBC.INI file must be modified so that each user has a
different package name. Either the library name or the first 7 characters of the package
name can be changed.

A user must have *USE authority to the CRTSQLPKG command on the AS/400 and
*ADD authority to the library to be able to create a package. The package is created
when the first statement is added. A user must have *USE authority to the package
itself to use the package *CHG authority to add statements to the package.

SQL statements stored in the package must match the SQL statement sent from the
client exactly for the stored statement to be used. The two statements are compared
character by character to determine a match. Blanks are significant.

 Brio DataPrism
Brio DataPrism** supports AS/400 as a data source. If this is selected you must
specify System Naming for the naming convention when setting up the data source.

Client Access/400 Database Access
There are no known changes required for Client Access/400 Database Access
(included with Client Access/400 for Windows).

Computer Associates Visual Express
Computer Associates Visual Express requires that a unique index must be available for
any file that you want to be able to update with Visual Express.

Crystal Reports for Visual Basic
There are no known changes required for Crystal Reports for Visual Basic.

 Lotus Approach
Lotus Approach** requires that a unique index must be available for any file that you
want to be able to update with Approach. Add the following entry to the
APPROACH.INI file that is located in your Windows directory. The entry should be
added under the ODBC heading.

Client Access/4ðð ODBC Driver=16

 Lotus 1-2-3
Add the following entries to the LOTUS.BCF file located in the \LOTUSAPP\DATALENS
subdirectory:

3-12 Client Access/400 for Windows 3.1 User Guide  



DN="AS/4ðð"
DL="DLODBC"
DD="ODBC for the AS/4ðð"
DC="driver=ehnodbc3.dll"

Where:

DN is the name 1-2-3** uses to identify the the Client Access/400 ODBC driver.

DL=DLODBC  tells 1-2-3 that this will be an ODBC connection.

DD is a text description of the driver.

DC specifies the actual name of the ODBC driver to be used (EHNODBC3.DLL).

 Microsoft Access
Microsoft Access** requires that a unique index must be available for any file that you
want to be able to update with Access. The MEMO data type supported by Access is
not supported by the AS/400. The ODBC driver has no way to map a MEMO field to a
character field. A large CHAR or VARCHAR field should be used instead of a MEMO
field.

 Microsoft Excel/Query
There are no known changes required for Microsoft Excel**/Query.

Microsoft Visual BASIC
Microsoft Visual BASIC Professional V3.0** requires that a unique index must be avail-
able for any file that you want to be able to update with Visual BASIC. The TABLEDEF
command does not work on the AS/400. TABLEDEF tries to create a table with one
column defined and then add the rest of the columns using alter table commands. This
use of the alter table command is not supported on the AS/400.

 Powersoft Products
Powersoft PowerBuilder V3.0a**, Powersoft PowerMaker V3.0a**, and Powersoft
PowerView V3.0a** require that a unique index must be available for any file that you
want to be able to update with the Powersoft products. Add the following entries to the
PBODB030.INI file located in the product directory (PB3 for PowerBuilder, PM3 for
PowerMaker, or PV3 for PowerView):

[DB2/4ðð]
DelimitIdentifier='YES'
PBCatalogOwner='libname'
PBDateTime='ISO_TIMEDATE'
IdentifierCase=3

Where libname  is an AS/400 library to which the user has access.

Also, add a section with the following heading and entries (note that the indented lines
are continuations of the lines directly above):

  Chapter 3. Accessing Databases with Client Access/400 for Windows 3.1 3-13



[DB24_SYNTAX]
AlterForeignKey='ALTER TABLE &TableOwner.&TableName

FOREIGN KEY &KeyName
 (&ColumnName[,&ColumnName]...)
 REFERENCES &RefTableName'
AlterPrimaryKey='ALTER TABLE &TableOwner.&TableName

PRIMARY KEY (&ColumnName[&ColumnName]...)'
CreateTable='CREATE TABLE &TableOwner.&TableName
 (::ColumnElement[,
 ::ColumnElement]...)'
ColumnElement='&ColumnName &DataType &NotNull'
CreateIndex='CREATE &UNIQUE INDEX &IndexName ON
 &TableOwner.&TableName
 (::ColumnIndex[,
 ::ColumnIndex]..)'
DropTable='DROP TABLE &TableOwner.&TableName'
DropView='DROP VIEW &TableOwner.&TableName'
DropIndex='DROP INDEX &IndexName'
DropPrimaryKey='ALTER TABLE &TableOwner.&TableName

DROP PRIMARY KEY'
DropForeignKey='ALTER TABLE &TableOwner.&TableName

DROP FOREIGN KEY &KeyName'

 ShowCase Vista
There are no known changes required for ShowCase Vista.

Using Database Access
Now that you have built your data source and connected to it, you can use the func-
tions of Database Access to manipulate data to use however you want to. And you do
not have to know anything about SQL!

Subtopics are:

� “Building Queries Using Database Access”
� “Joining Tables Using Database Access” on page 3-15
� “Forming Groups Using Database Access” on page 3-15

Building Queries Using Database Access
You can use the query builder to build SQL queries.

1. Double-click on the Database Access icon.

2. Select the Build Query Statement button from the tool bar. This opens the Query
Builder dialog box that you can use to create an inventory query.

3. Select the library to use.

4. Select the tablename to use.

5. Select the columns you want to view.

6. Select the Query Criteria button to limit the information that you want included in
your query. Indicate that you are through by choosing the Done button.

7. Select the columns to organize the data by.
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8. Select the Execute button to run the query.

While you were building your query by selecting tables, columns, and so forth, Data-
base Access was building your SQL statements. These statements are displayed in
the Query Statement box.

Joining Tables Using Database Access
To set joins between two or more tables, choose the Set Joins... button. In the Join
Tables dialog box, you can define joins between one or more tables by specifying the
tables to join and the columns (fields) they are to be joined on. When you run the
query, the system logically creates the Cartesian product of the joined tables. The
Cartesian product is a set that is constructed from two given sets and comprises all
pairs of elements such that one element of the pair is from the first set and the other
element is from the second set.

To specify the join criteria:

1. In the Select Table Pair list box, specify the two tables by selecting them one at a
time. The columns in those tables appear in the Select Columns to Join Selected
Tables on list boxes.

2. Click on one column in each of the Select Columns to Join Selected Tables on list
boxes. These must be equivalent columns.

3. Select the ADD Join to Query button. The criteria appear in the Join Criteria box.

4. To add more join criteria, repeat steps 1 and 2, but notice that the ADD Join to
Query button has been replaced by two new buttons: the AND Join to Query button
and the OR Join to Query button.

5. To AND the current criteria into the clause, choose the AND Join to Query button.
To OR the current criteria into the clause, choose the OR Join to Query button.
The criteria appear in the Join Criteria box.

6. Continue to add join criteria in this fashion until you are finished.

7. Select the Done button.

Forming Groups Using Database Access
To form groups from the retrieved information, choose the Group By... button. The
Group By Criteria dialog box lets you specify columns in which to group the retrieved.
You can include an aggregate function in the Group By clause. To set Group By cri-
teria, do the following:

1. Select a function in the Aggregate Function drop-down list box.

2. Select a column for the function to operate on from the Column drop-down list box.

3. Select the columns to appear after the aggregate function from the Add Group By
Columns list box. (In most cases you must select all columns listed.)

4. Select the Add Aggregate Criteria button. The criteria are displayed in the Group
By Aggregate Function box.

5. Repeat this process for additional functions.
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6. When you are finished setting Group By criteria, select the Done button and the
Group By clause is added to the query.

7. Use the Order By list box to create an ORDER BY clause in the query. An
ORDER BY clause specifies the order of the rows to be returned by the query. To
specify the order of the columns in the query, select the columns in the Order By
list box. Use the scroll bar at the right of the list box to scroll through the list. The
order in which you select the columns is the order in which they will appear.

8. Enter a descriptive name in the Description text field. This name identifies your
query and is used to recall the query later, so the name you use must be unique.

9. Select the Save Query button to save the query.

10. Select the Execute button to run the query.

11. Select the Reset All button to reset the Query Builder dialog box and start over.

12. Select the Close button to exit the Query Builder dialog box.

 Hint 

A saved query can be recalled by selecting the list box to the right of the box below
the tool bar.
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 Chapter 4. Printing

Client Access/400 for Windows 3.1 allows you to take advantage of the enhanced
capabilities of printers attached to the AS/400 from Windows applications, such as:

� Print text, lines, boxes, images, graphics, or bar codes at any point on a page.

� Print text in a variety of type styles, and switch fonts within a printed page.

� Use both images and graphics to print line drawings, bar charts, graphics, logos,
tables, and signatures.

� Combine text with images and graphics on the same page (creating what is known
as a composite document).

� Print bar codes in any size with a number of variations.

The following printer drivers are included with Client Access/400 for Windows 3.1:

 � AFP driver
 � SCS driver

The AFP printer driver allows you to print data, including graphics, from Windows appli-
cations on printers that support Advanced Function Printing (AFP). These printers
include IBM 3812-2, IBM 3816, and IBM 3835 printers.

The SCS printer driver allows you to print data from Windows applications on printers
that support the SNA Character Stream (SCS). These printers include IBM 3816, IBM
3812, and IBM 5219. It is important to note that the SCS driver produces only text;
therefore, it is best used with word processor, spreadsheet, database, and other text
applications.

Because some AS/400-attached printers, like the IBM 3812 and IBM 3816, can support
either AFP or SCS, you must be aware of the current configuration of the AS/400
printer that you choose. If the printer is configured to support AFP data, it can also
print SCS data. If the printer is configured to support SCS only, attempting to print an
AFP file causes an error.

You can install both printer devices and select the appropriate device from within the
application when you are ready to print.

Subtopics:

� “Installing Printer Drivers” on page 4-2
� “Configuring Printer Drivers” on page 4-2

Related Topics:

� “Managing Virtual Printers” on page 2-6

 Copyright IBM Corp. 1995  4-1



Installing Printer Drivers
To install the AFP or SCS printer driver:

1. Double-click on the Setup icon in the Client Access/400 for Windows 3.1 group
window.

2. Double-click on the Printer icon.
3. Select the printer driver to install on your PC.

 4. Select OK.

This will install a default device for the printer driver that you selected. To configure
this device, see “Configuring Printer Drivers.”

To install additional printer devices for the AFP or SCS printer drivers:

1. Double-click on the Configuration icon in the Client Access/400 for Windows 3.1
group window.

2. Select Install Printer Devices.
3. Select the AFP or SCS Driver.
4. Select the device or devices to install from the list.

 5. Select OK.

This will install the selected printer devices. To configure the devices, see “Configuring
Printer Drivers.”

Configuring Printer Drivers
To configure a printer driver that is already installed on your PC:

1. Double-click on the Control Panel icon on the Windows Main group window.

2. Double-click on the Printers icon.

3. Select the printer driver in the list window to highlight the driver.

4. Select the Setup button.

See the online help for information if you need help setting up the driver.

5. Select the Connect button to assign the driver to a printer port.

 6. Select OK.
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 Chapter 5. File Serving

File sharing is as simple as dragging and dropping a file when you use the file serving
capabilities of Client Access/400 for Windows 3.1 File Manager. You can share a file
between PCs by doing the following steps:

1. “Creating a Network Connection”
2. “Copying a File to an AS/400”

Creating a Network Connection
After you have started a connection to your AS/400, do the following:

1. Double-click on the Folders icon.
2. Select the Device letter and the Network Path name on the Network Connections

window.
3. Select the Connect button. The Current Connections dialog box will display the

AS/400 connection.

Note:  You also can create a network connection by using the File Manager.

Copying a File to an AS/400
After you have started a connection to your AS/400, do the following:

1. Double-click on the File Manager icon in the Windows Main Window.
2. Select the Window pull-down menu.
3. Select New Window from the pull-down menu.
4. Select the letter of the network drive.
5. Select Tile from the Window pull-down menu.
6. Drag the file from your PC over the desired directory on the AS/400 by using your

mouse.

The file now exists on both the PC and on the AS/400. If a user on another PC wants
a copy of the file, the process can be reversed...just copy from the AS/400 to the new
PC.
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Chapter 6. Sending E-Mail Using the Messaging Application
Program Interface (MAPI)

The messaging application program interface (MAPI) is a set of functions that your
applications can use to create, manipulate, transfer, and store messages and attach-
ments. MAPI refers not only to the client interface but to the entire system architecture,
which includes client applications, MAPI system software, and service providers.

Subtopics:

 � “Client Applications”
 � “Messaging-Aware Applications”
� “Messaging-Enabled Applications” on page 6-2
� “Messaging-Based Workgroup Applications” on page 6-2
� “MAPI System Software” on page 6-2
� “Service Providers” on page 6-2
� “Getting Started with Client Access/400 MAPI Functions” on page 6-3

– “MAPI Environment” on page 6-3
– “Prerequisites for Using Simple MAPI Clients” on page 6-3
– “Office Vision for OS/400 MAPI Drivers Installation” on page 6-4
– “RUMBA/400 Terminal Session Configuration” on page 6-4
– “Recording a RUMBA/400 Macro” on page 6-4
– “PC5250 Session Configuration” on page 6-4
– “Recording a PC5250 Macro” on page 6-5

� “Using MAPI” on page 6-5
� “Sending Messages and Attachments” on page 6-5

 Client Applications
Your interaction with the MAPI system is by means of client applications. These appli-
cations allow you to send messages and attachments such as Word documents, Excel
spreadsheets, and PowerPoint presentations from the application. You can send mes-
sages and attachments directly from the application.

There are three types of client applications: messaging-aware applications, messaging-
enabled applications, and messaging-based workgroup applications.

Subtopics:

 � “Messaging-Aware Applications”
� “Messaging-Enabled Applications” on page 6-2
� “Messaging-Based Workgroup Applications” on page 6-2

 Messaging-Aware Applications
Applications that are messaging-aware are also known as simple-MAPI clients. Mes-
saging functions are an added, but not required feature of these clients. A basic level
of messaging is implemented by adding a Send command to the File pull down menu
of the application. These applications can send messages and attachments, but a sep-
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arate application is necessary to receive messages and attachments. Examples of
those applications are:

� Microsoft Word 6.0
� Microsoft Excel 5.0
� Microsoft PowerPoint 4.0

 Messaging-Enabled Applications
Applications that are messaging-enabled are also known as extended-MAPI clients.
These applications require messaging functionality as they are able to both send and
receive messages and attachments. An example of these applications is Microsoft
Mail.

Messaging-Based Workgroup Applications
Messaging-based workgroup applications are designed to operate over a network
without your having to manage the applications' network interaction. Full access to a
wide range of messaging services is required. The messaging services include the
message store, address book, and message transport functions. Examples of
messaging-based workgroup applications are:

� Bulletin board services
� Work-flow automation programs

MAPI System Software
The MAPI subsystem is part of the computer's operating system. The subsystem
responds to messaging calls from client applications and coordinates the running of the
requested actions. This action is done by directing the flow of client requests to mul-
tiple transport-service providers. MAPI does not replace messaging systems (for
example, Microsoft Mail, Novell MHS, X.400, IBM OfficeVision for OS/400), but it acts
as a central clearinghouse to unify the various messaging services and to shield clients
from their differences.

The subsystem includes a set of MAPI dynamic-link libraries (DLLs) that contain the
drivers for the transport providers and the message spooler. The message spooler
buffers items and sends them to the correct destination. The spooler works closely with
the message store and transport providers when it is sending and receiving messages.

 Service Providers
The MAPI subsystem contains three types of service providers: message store service
providers, address-book service providers, and transport service providers.

� The message store provider is a store-and-forward function that receives mail,
even when the mail clients are not on-line. This provider supplies message
storage, organization, and retrieval functions for a messaging system.

� The address book provider supplies message addressing and distribution list func-
tions to the messaging client.
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� The transport provider moves messages between messaging clients. This provider
uses any transport mechanism available to send and receive messages.

When a MAPI application starts, the MAPI subsystem starts all three providers, which
handle requests from any MAPI client application.

Getting Started with Client Access/400 MAPI Functions
Subtopics covered in this section are:

 � “MAPI Environment”
� “Prerequisites for Using Simple MAPI Clients”
� “Office Vision for OS/400 MAPI Drivers Installation” on page 6-4
� “RUMBA/400 Terminal Session Configuration” on page 6-4
� “Recording a RUMBA/400 Macro” on page 6-4
� “PC5250 Session Configuration” on page 6-4
� “Recording a PC5250 Macro” on page 6-5

 MAPI Environment
For the AS/400 host, you need the following:

� Version 3 Release 1
 � OfficeVision/400

For the PC workstation, you need the following:

 � Windows 3.1
 � MAPI-enabled clients
� Client Access/400 for Windows 3.1
� RUMBA/400 or PC5250

Prerequisites for Using Simple MAPI Clients
Before you can use MAPI, you must ensure the following:

� All MAPI users are enrolled as Office Vision/400 users on the AS/400.
� All MAPI users have write access to their Office Vision/400 folders on the AS/400.

Without write access, the transport provider is not able to copy messages and
attachments to the Office Vision/400 folder.

� Subsystems QSNADS, QSERVER, QCMN are started on the AS/400.
� Office Vision/400 MAPI drivers are installed on the PC workstation. Refer to

“Office Vision for OS/400 MAPI Drivers Installation” on page 6-4 for steps for
installing the MAPI drivers.

� A RUMBA/400 terminal session or a PC5250 session is properly configured.
� If PC5250 is used, at the Office Vision/400 panel you should do the following:

Select 9. Administration
Select 1. Change Enrollment
Select 6. Environment Information
Change word processing choice to equal 2.

� If there are any special screens or menus (other than the Command Entry screen,
AS/400 Main Menu, or the Office Vision/400 menu), after signing onto the terminal
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session such as bulletin boards, new messages, and so on, you may want to
record a macro to get past these screens and to ensure MAPI will work correctly.

Note:  If these screens change, the macro will also have to be changed accord-
ingly.

Office Vision for OS/400 MAPI Drivers Installation
To install Office Vision/400 MAPI drivers, do the following:

1. In the Client Access/400 for Windows group, double-click on the Setup icon.
2. In Setup, select Office Vision/400 MAPI Drivers. (All the necessary MAPI files will

be installed in their respective directories on the PC. A MAPI statement will be
added to WIN.INI.)

RUMBA/400 Terminal Session Configuration
To configure a RUMBA/400 terminal session, do the following:

1. Start a RUMBA/400 terminal session.
2. From the Options pull down menu, select Interface.
3. On the Interface screen, select Client Access/400.
4. From the Session pull down menu, select Autoconnect, Autodisconnect, and

EHLLAPI Configuration.
5. On the EHLLAPI Configuration screen, check EHLLAPI SDK and enter any letter

for a Short Name.
6. Save the session profile by giving it any name.
7. Include the following entry in WIN.INI if it is not already there:

[CAMAPI]
HLL=C:\RUMBACAW\EEHLLAPI.DLL

Recording a RUMBA/400 Macro
To record a RUMBA/400 macro, do the following:

1. Start a configured RUMBA/400 terminal session.
2. Select Record from the Macro pull-down menu.
3. Enter your USERID, password, and any other steps or commands necessary to get

to any of the following screens:
  Command Entry

AS/400 Main Menu
Office Vision/400 Menu

4. Select Record from the Macro pull-down menu.
5. Enter a key name and description.
6. Select Save from the File pull-down menu and name the new file.
7. Select Auto Macro from the File pull-down menu and close the panel.
8. Close the terminal session and save the changes.

PC5250 Session Configuration
To use a PC5250 session for MAPI, do the following:

1. Start and configure a PC5250 session.
2. Verify that Autoconnect is checked under the Communication pull-down menu.
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3. Save the session profile by giving it any name.
4. Verify that the following entry is included in WIN.INI.

[CAMAPI]
HLL=C:\PCOMWIN\PCSEEHLL.DLL

Recording a PC5250 Macro
To record a PC5250 macro, do the following:

1. Start a configured PC5250 terminal session.
2. Select Start Recording Macro from the Assist pull-down menu.
3. Give the macro a FILENAME and description; click OK.
4. Enter your USERID, password, and other steps or commands necessary to get to

any of the following screens:
  Command Entry

AS/400 Main Menu
Office Vision/400 Menu

5. Select Stop Recording Macro from the Assist pull-down menu.
6. Select Macro Setup from the Assist pull-down menu.
7. Select the macro that is just recorded and click OK.
8. Close the terminal session and save the changes.

 Using MAPI
To start MAPI, do the following:

1. Connect to a Version 3 Release 1 AS/400 system.

2. Assign a folder.

Note:  MAPI will assign a folder for you if you do not do this step.

3. Start a configured RUMBA/400 or PC5250 session.

Note:  If you are using RUMBA/400, MAPI can automatically start the configured
terminal session. If you are using PC5250, you must start the configured terminal
session and minimize the session.

4. Start a simple MAPI client (for example, WORD 6.0, EXCEL 5.0, or PowerPoint
4.0).

Sending Messages and Attachments
Before you can open any MAPI client applications, you must start a router to an
AS/400. Once the router has been started, a MAPI client application can be started,
and messages and attachments can be sent.

To send messages and attachments:

1. Select Send from the File pull down menu of the MAPI client application.

2. From the Choose Your Messaging Profile panel:
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a. Accept the default profile. The default profile starts the message store,
address book, and transport providers.

 b. Click OK.

3. From the Configure Wall Data Local Message Database panel:

a. Use the Browse button to select an existing message-folders file or to create a
new message-folders file.

b. Enter a brief description for Display Name.

Note:  The Local Message Database menu appears once after the installation of
the Office Vision/400 MAPI drivers. This menu only appears again if the client
application is unable to open the message store file.

4. From the Address Book Configuration panel:

a. Enter a title for the address book.
b. Select the Browse button and either:

� Enter the name of an existing address book file.
� Enter a new file and select Yes when prompted to create the address

book file.

Note:  The Address Book Configuration menu appears once after the installation
of the Office Vision/400 MAPI drivers. This menu only appears again if the client
application is unable to open the address book file.

5. From the Office Vision/400 Provider Configuration panel do the following:

a. Under the HOST tab, enter the following:

Display Name The user's name
User ID The user's AS/400 Signon ID
System Name The name of the AS/400
Password The user's AS/400 password
Mail Folder Name The user's folder on the AS/400 (Use the folder that

was assigned to the user when the user was enrolled
in Office Vision/400.)

b. Under the Connections tab, enter the following:

Full Workstation Path\File
The path and FILENAME of the configured
RUMBA/400 or PC5250 terminal session.

Session ID The default (*).
PC Work Dir The directory where temporary data can be stored

during the send message process.
Save Logon Information

If this is checked, all the information in this panel will
be saved and displayed the next time a message is to
be sent.

Always Show Logon This is checked so that this panel is always displayed
the first time a MAPI client attempts to send a
message.

c. From the Send Mail panel, do the following:
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To, Cc, Bcc buttons These buttons take you to the Untitled panel. At this
panel:

1) Open the address book (double click with the mouse).
2) Highlight the message recipient name.
3) Select To for a primary message recipient.
4) Select Cc to have a copy of the message sent to the

recipient.
5) Select Bcc to have a copy of the message sent to the

recipient without being identified to any of the other
recipients.

Note:  If a display name that is not valid is entered, the
Check Names panel appears and allows you to enter a dif-
ferent name.

Subject Enter the subject of the message and attachment and enter
the body of the message in the box below the subject line.

Attachments Add or delete attachments.

To add attachments:

1) Click the ADD button.
2) Select the file to be attached.

To delete attachments:

1) Highlight the attachment to be deleted.
2) Select the DELETE button.

d. The Resolve... button allows you to type in a message recipient's name or a
partial name. MAPI then checks the user's address book for a match. If a
match is found, the complete name is displayed. If no match is found, the
Check Names panel appears and allows you to enter a different recipient
name. Do the following:

1) Type the name or a partial name of a message recipient.
 2) Select Resolve...

e. If at the Untitled panel do the following:

1) Open the address book (double click with mouse).
2) Highlight the message recipient.
3) Select the To button for direct copy.
4) Select the Cc button for carbon copy.
5) Select the Bcc button for blind carbon copy.

The New Entry... button allows you to add entries to the address book.

To add entries to the address book, do the following:

1) Select the New Entry button.
2) Select General Mail User from the New Address Entry panel.
3) Enter the following information in the Properties panel:

Display Name: Enter the user's name.
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Email Address: Enter the user's electronic address in the form: User
ID.System Name

Note:  Entries are added permanently to the address book. They can be
changed but not deleted.

To change any entries in the address book, do the following:

1) Highlight the address book entry to be changed.
2) Select the Properties... button.
3) Change any pertinent information

The Properties... button allows you to view and change the information for an
entry in the address book.

f. The Send Options button is not implemented at this time.

6. If at the Check Names panel, do the following:

a. If the name is listed, select the desired recipient name.
b. If the name is not listed, select the Choose Other button. This button brings

up the Choose Alternative Recipient panel that lists all the available entries in
the address book.

c. Select the desired recipient name.
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 Chapter 7. Using Emulators

Client Access/400 for Windows includes two emulator products, RUMBA/400 and Per-
sonal Communications 5250. Both emulators are similar in function and provide both
5250 and printer emulation with an easy-to-use graphical interface. The products must
be installed on the AS/400 in order to use any of the functions.

This section provides some of the basic tasks associated with the emulators. More
detailed user task information is provided in the following publications:

� RUMBA/400 User Guide, SC41-3550
� PC5250 Setup (User's Guide), SC41-3552

Subtopics:

 � “RUMBA/400 Basics”
� “Personal Communications 5250 Basics” on page 7-3

 RUMBA/400 Basics
The RUMBA/400 product is shipped in the QPWXCRB directory (QPWXCRBD directory
for double-byte) on the AS/400.

Subtopics:

� “Creating a 5250 Session”
� “Creating a 5250 Session with Auto Sign-on” on page 7-2
� “Creating a Printer Session” on page 7-2
� “Using File Transfer” on page 7-3

Creating a 5250 Session
To create a 5250 session:

1. Double-click on the Terminal icon in the RUMBA/400 window group.

2. Select the Connect icon on the tool bar, or select Connect under the Sessions pull-
down menu.

Note:  To create a session to a system other than the default system, select the
Session configuration option on the Sessions pull-down menu.

To save a session and create an icon for the session:

1. Create a 5250 session as described above.
2. Select the Save or Save as option from the File pull-down menu to save the

session profile.
3. Enter a name for the session profile with a WSF extension.
4. Under the Program Item area, select the Create an icon check box and enter a

description for the icon.
5. Use the down arrow to select the group window where you want to place the icon.

 6. Select OK.
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Creating a 5250 Session with Auto Sign-on
One of the nice features of RUMBA/400 is that you can create a 5250 session that
by-passes the AS/400 sign-on prompt when the session is started.

To create a 5250 session with auto sign-on:

1. Double-click on the Terminal icon in the RUMBA/400 window group.
2. Select the Session pull-down menu on the RUMBA/400 session window.

 3. Select Autoconnect.
4. Select the Session pull-down menu again.
5. Select Session Configuration.
6. Use the down arrow to select the system name.
7. Select the check box for Auto Sign-on.

 8. Select OK.
9. Select the Save or Save as option from the File pull-down menu to save the

session profile.
10. Select the Session pull-down menu, then select Connect if you want to start the

session immediately.

Creating a Printer Session
To create a printer session:

1. Double-click on the Printer icon in the RUMBA/400 window group.
2. Select the Connect option under the Sessions pull-down menu.

 Hint 

To create a session to a system other than the default system, select the Session
configuration option on the Sessions pull-down menu. The device name, message
queue, and message library fields are optional.

Device name defaults to session ID
Message queue defaults to QSYSOPR
Message library defaults to QSYS

To save a session and create an icon for the session:

1. Create a printer session as described above.
2. Select the Save or Save as option from the File pull-down menu to save the

session profile.
3. Enter a name for the session profile with a PRN extension.
4. Under the Program Item area, select the Create an icon check box and enter a

description for the icon.
5. Use the down arrow to select the group window where you want to place the icon.

 6. Select OK.

Note:  Device name, message queue, and message library fields are optional.

Device name defaults to session ID
Message queue defaults to QSYSOPR
Message library defaults to QSYS
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Using File Transfer
A file transfer option is provided on the 5250 session window menu bar. Starting File
Transfer from the 5250 session window is the same as double-clicking on the File
Transfer icon in the Client Access/400 group window.

See “Transferring Data Using File Transfer” on page 3-1 

Personal Communications 5250 Basics
The Personal Communications 5250 product is shipped in the QPWXCPC directory on
the AS/400.

Subtopics:

� “Creating a 5250 Session”
� “Creating a Printer Session”
� “Using File Transfer” on page 7-4

Creating a 5250 Session
To create a 5250 session:

1. Double-click the Start/Configure Session icon in the PC 5250 group window.
2. If you need to change the any of the session defaults, select the Configure... option

from the Communication pull-down menu. For example, creating a session for an
AS/400 that is not the default system.

To create an icon for the 5250 session:

1. Create a 5250 session as described above.
2. Select the Save or Save as option from the File pull-down menu to save the

session profile.
3. Enter a name for the session with an extension of WS.

 4. Select OK.
5. Select Yes when asked if you want to create an icon.

Note:  The create an icon message is not displayed unless you are saving a
session with a new name.

Creating a Printer Session
To create a printer session:

1. Double-click the Start/Configure Session icon in the PC 5250 group window.
2. Select the Configure... option from the Communication pull-down menu.
3. Select the Printer radio button for Session Type.
4. Use the Advanced... or Configure Link... buttons if you want to change the session

defaults. See the online help information for a description of the fields.

To create an icon for the printer session:

1. Create a printer session as described above.
2. Select the Save or Save as option from the File pull-down menu to save the

session profile.
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3. Enter a name for the session with an extension of WS.
 4. Select OK.

5. Select Yes when asked if you want to create an icon.

Note:  The create an icon message is not displayed unless you are saving a
session with a new name.

Using File Transfer
A file transfer option is provided on the 5250 session window menu bar. Starting File
Transfer from the 5250 session window is the same as double-clicking on the File
Transfer icon in the Client Access/400 group window.

See “Transferring Data Using File Transfer” on page 3-1 
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Chapter 8. Using System Object Access

System Object Access gives you access to the following common OS/400 objects:
printers, printer output, jobs, job logs, and messages. You can easily access a graph-
ical list for each of these objects by clicking on the System Object Access icon on the
Client Access/400 for Windows 3.1 group window.

System Object Access also includes APIs which applications can use to access data
from these objects, or display graphical lists and attribute views of the object data.
Sample programs and source code for the sample programs are provided in the Client
Access/400 for Windows 3.1 Toolkit (5763-XM1).

The AFP Viewer (a subset of the Advanced Function Presentation Workbench product)
is included with System Object Access to provide powerful viewing capabilities. The
viewer is used to view the contents of OS/400 printer output from the Printer Output
List, or by using a System Object Access API. The viewer can also be used by clicking
on the AFP Viewer icon on the Client Access/400 for Windows 3.1 group window to
view files on your workstation or in a shared folder (network drive).

Subtopics:

� “Selecting the AS/400 to Access”
� “Installing System Object Access” on page 8-2
� “Printer Output” on page 8-2
� “AFP Viewer” on page 8-6
� “Jobs” on page 8-9
� “Printers” on page 8-12
� “Messages” on page 8-14
� “Job Log” on page 8-16
� “Saving System Object Access Customization” on page 8-18

Selecting the AS/400 to Access
System Object Access gives you access to the following common OS/400 objects:
printers, printer output, jobs, job logs, and messages. The current Client Access/400
default system is used to access the objects unless you specify a different system.

To specify a different AS/400 system:

1. Select System on the System Object Access group menu bar.
2. Choose Select AS/400 system from the pull-down menu.
3. Type the name of the system.

 Hint 

If you do not know which systems are currently connected, or you want to start
a connection to a different AS/400, click on the AS/400 Connection button.
Then return to the Select AS/400 system prompt and enter the name of the
system.
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4. Click on OK.

Subtopic:

� “Accessing Multiple Systems”

Accessing Multiple Systems
Selecting System  from the menu bar enables you to specify which AS/400 you want to
use for the functions that you select. You can also use System Object Access func-
tions with multiple AS/400 systems. This includes using the same function with more
than one AS/400 system.

For example, to work with printer output on more than one AS/400 system:

1. Select System on the menu bar.
2. Choose Select AS/400 System from the pull-down menu.
3. Select OK to use the default system name, or select the AS/400 connection button

to choose a different system name.
4. Select the Printer Output icon to work with printer output on the system you just

selected.
5. Repeat the above steps to select the second AS/400 system and work with the

printer output on that system.

You should have one window displayed for each AS/400 system selected.

Installing System Object Access
To install System Object Access:

1. Double-click on the Setup icon in the Client Access/400 group window.
2. Select the System Object Access entry in the list window.

 3. Select OK.

Note:  System Object Access requires the Host Servers feature of OS/400 to be
installed.

 Printer Output
The printer output function of System Object Access allows you to work with printer
output that is waiting to be printed. You can perform actions against this output, such
as, open, hold, release, move, delete, and so forth. You can also change the proper-
ties of the output, such as, the printer, number of copies, the priority, the form type,
etc..

Subtopics:

� “Working with the Printer Output List” on page 8-3
� “Viewing Printer Output Contents” on page 8-4
� “Changing Printer Output Properties” on page 8-4
� “Changing Properties from a List Window” on page 8-4
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� “Changing Properties using the Properties Window” on page 8-4
� “Customizing the Printer Output List Content” on page 8-5
� “Customizing the Printer Output List Window” on page 8-5
� “Sending Printer Output to Another AS/400 System” on page 8-6

Working with the Printer Output List
Selecting the Printer Output icon displays a window which lists spooled files on the
selected AS/400 system.

To perform an action against one or more items in the list:

1. Select the item or items to perform the action on.

 Hint 

Press the left mouse button to select a single item. Use the Shift key + the left
mouse button to select a block of items, or use the Ctrl key + the left mouse to
select multiple items that are not listed together.

2. Select the action to perform using one of the following methods:

� Press the right mouse button to display a pop-up menu, then select the action
item.

� Select File from the menu bar and then select the desired action.

� Select the tool bar icon that represents the action you want to perform (not all
actions are available using the tool bar).

Note:  You can perform the default action for an item in the list by double-clicking on
the item in the Printer Output List. The default action is the first item on the
action pop-up menu.

See “Saving System Object Access Customization” on page 8-18 for details of saving
the layout of list panels.

  Chapter 8. Using System Object Access 8-3



Viewing Printer Output Contents
You can view the contents of any entry on the Printer Output List window using any of
the following methods:

� Select File followed by Open from the menu bar.
� Select the Open icon on the tool bar.
� Double-click on the output name.

See “AFP Viewer” on page 8-6 for an overview of the AFP Viewer.

Changing Printer Output Properties
There are two different ways to change the properties of an item on the Printer Output
List:

� If the property you want to change appears as one of the column headings on the
Printer Output List (for example Printer), you can change the property right on the
list.

See “Changing Properties from a List Window”

� Any property that can be changed for an item in the Printer Output List, can be
changed by selecting the item then selecting the Properties action.

See “Changing Properties using the Properties Window” 

Changing Properties from a List Window
To change a property for an item in the List window:

1. Select the item you want to change.

Click on the item with the left mouse button, or move the cursor up or down to
highlight the item.

2. Depending on the property you want to change, the current data appears with one
of the following type of controls:

Edit Type the new data and press Enter.

Down arrow Click on the arrow to select the new data, or just type the new data
and press Enter.

Right arrow Click on the arrow to open a dialog box. Use the dialog box to
change the property, then click on OK.

Changing Properties using the Properties Window
The Properties window lets you change properties for an item on the List window.

To access the Properties window:

1. Select the item you want to change.

Click on the item with the left mouse button, or move the cursor up or down to
highlight the item.
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2. Press the right mouse button and select the Properties action, or click on the Prop-
erties icon on the tool bar.

Initially, only the basic properties are shown. Click on the Advanced button to
display all the properties for the selected item on the List window.

3. Make any change you want, then select OK to change the properties on the
AS/400.

Customizing the Printer Output List Content
The content of the Printer Output List window List can be customized using the fol-
lowing options under the View pull-down menu:

 � Sort by
 � Include
 � Columns

Sort by  allows you to sort Printer Output List entries by one or more columns. You can
also sort the items in the list by a specific property by double-clicking on the column
heading for that property on the list.

Include  allows you to specify the printer output to include on the Printer Output List.
You can choose to include printer output by user, printer, output queue, form type, user
data, status, and job name.

Columns  allows you to specify which columns are included in the Printer Output List.

Customizing the Printer Output List Window
The following methods can be used to change the way the Printer Output List window
looks:

Column width:  To change the width of a column:

1. Position the mouse pointer on the column separator line to the right of the column
heading you want to change. A double arrow is displayed when the mouse point is
on the line.

2. Hold down the left mouse button and move the mouse pointer to the left to make
the column narrower and to the right to make it wider. Wider columns will allow
you to see more information in the columns, but will reduce the number of columns
that you can see at the same time on the screen.

Fonts:  To change the fonts used in the Printer Output List window, select the Fonts
option from the Options pull-down menu.

Status bar:  To specify whether or not the Status bar is displayed on the Printer Output
List window, select the Status bar option from the Options pull-down menu.

Tool bar:  To specify whether or not the Tool bar is displayed on the Printer Output List
window, select the Tool bar option from the Options pull-down menu.
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Information area:  To specify whether or not the Information area is displayed on the
Printer Output List window, select the Info area option from the Options pull-down
menu.

Sending Printer Output to Another AS/400 System
To send printer output to a user on another AS/400 system:

1. Click on the entry that you want to send to highlight it.
2. Select the Send option from the File pull-down menu, or click on the Send icon on

the tool bar.
3. Fill in the user name and system name entry fields.
4. Select the Send button.

The output is placed in the output queue specified in the user profile of the person
receiving the file.

 AFP Viewer
A subset of the Advanced Function Presentation Workbench product called the AFP
Viewer is included with System Object Access. The AFP Viewer provides powerful
viewing capabilities. The viewer allows you to view the contents of AS/400 printer
output from the Printer Output List. Also, if you start the viewer with the AFP Viewer
icon, you can view files on your workstation or in shared folders (network drives).

To view AS/400 spooled files from the Printer Output List window:

1. Double-click on the System Object Access icon on the Client Access/400 for
Windows group window.

2. Double-click on the Printer Output icon on the System Object Access group
window to display a list of printer output.

3. Select the printer output item you want to view.

Click on the item with the left mouse button, or move the cursor up or down to
highlight the item.

4. Press the right mouse button and select the Open action, or click on the Open icon
on the tool bar.

To view files on your workstation or in a shared folder:

1. Double-click on the AFP Viewer icon on the Client Access/400 for Windows group
window to start the stand-alone viewer.

2. Use the Open dialog box to select the file to view.

Note:  The stand-alone viewer cannot be used to view AS/400 spooled files.

8-6 Client Access/400 for Windows 3.1 User Guide  



Application Programming Interface

The EHNSO_DisplaySplf  API provided by the System Object Access application
programming interface can be used by applications to access the viewer. See the
Client Access/400 for Windows 3.1 API and Technical Reference, SC41-3531 for
programming information.

Subtopics:

� “AFP Viewer Functions”

AFP Viewer Functions
Some functions in the viewer subset provided with Client Access/400 for Windows 3.1
are supplied on a “try and buy” basis and are available only for the first 25 uses. When
you use the viewer function for the first time, a window is displayed explaining the “try
and buy” feature.

You can upgrade from the viewer to the full AFP Workbench for Windows feature for
Client Access/400 for Windows 3.1 for an extra charge. To display information about
upgrading the viewer, click on Upgrade on the viewer menu bar.

The following table lists the AFP Workbench for Windows features available during the
'Try and Buy' period, the features included with Client Access (Lite Product), and the
features available with the full AFP Workbench for Windows product (Full Product).
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Function Try and Buy Lite Product Full Product

Viewing AFP, SCS, ASCII AS/400
spooled file

Yes(3) Yes(3) Yes(3)

Viewing AFP, SCS, ASCII work-
station file

Yes(1) No Yes(1)

Viewing TIFF, PCX, DCX, DIB, GIF No No Yes

Viewing a fax Yes(4) Yes(4) Yes

True Type Font Support Yes Yes Yes

ATM & IBM Core Font Support No(2) No(2) No(2)

AFP Inline Form Definition Yes Yes Yes

AFP external resources when
viewing AFP spooled file

No No No

AFP external resources when
viewing AFP workstation file

Yes(1) Yes(1) Yes(1)

Workstation File Open Yes(1) No Yes(1)

Create Overlay No No Yes

Create Page Segment No No Yes

Copy Pages to File Yes No Yes

Print Yes No Yes

Copy Data to Clipboard Yes No Yes

Page Rotation Yes Yes Yes

Zoom Yes Yes Yes

Get, Save, Reset View Yes Yes Yes

Go To Yes Yes Yes

Find Group (ACIF Indexed) Yes No Yes

Find Yes Yes Yes

First, Last, Prev, Next Page Yes Yes Yes

Annotation on spooled file No No No

Annotation on workstation file Yes(1) No Yes(1)

Drag-Drop File Open Interface Yes(1) No Yes(1)

Toolbar, Status Line Yes Yes Yes

AFP printer driver No No Yes

DCF connection No No No
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Notes:

1. Viewer must be started as stand alone in order to use this function.

2. This function is supported if you install the ATM and IBM Core fonts separately.
Adobe Type Manager (ATM) is not provided with Client Access/400 or with the full
AFP Workbench product. If ATM is installed, IBM Core fonts are installed into the
ATM directory and used by the viewer to make the text look better.

3. Not all types of ASCII output can be viewed. Plain ASCII text can be viewed,
however, PCL and Postscript versions of ASCII text cannot be viewed.

4. Facsimile Support for OS/400 supports faxing of AFPDS and SCS spooled files.

 Jobs
The Jobs function of System Object Access allows you to perform actions against or
change the properties of jobs on the AS/400.

Subtopics:

� “Working with the Job List”
� “Changing Job Properties” on page 8-10
� “Customizing the Job List Contents” on page 8-10
� “Customizing the Job List Window” on page 8-11
� “Working with Printed Output for a Job” on page 8-11
� “Displaying a Job Log for a Job” on page 8-11

Working with the Job List
Selecting the Job List icon displays a window which lists jobs on the selected AS/400
system.

To perform an action against one or more items in the list:

1. Select the item or items to perform the action on.
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 Hint 

Click with the left mouse button to select a single item. Use the Shift key + the
left mouse button to select a block of items, or use the Ctrl key + the left
mouse to select multiple items that are not listed together.

2. Select the action to perform using one of the following methods:

� Press the right mouse button to display a pop-up menu, then select the action
item.

� Select File from the menu bar and then select the desired action.

� Select the tool bar icon that represents the action you want to perform (not all
actions are available using the tool bar).

Note:  You can perform the default action for an item in the list by double-clicking on
the item in the Job List. The default action is the first item on the action pop-up
menu.

For details of saving the layout of System Object Access list panels, refer to “Saving
System Object Access Customization” on page 8-18.

Changing Job Properties
There are two different ways to change the properties of an item on the Job List:

� If the property you want to change appears as one of the column headings on the
Job List, you can change the property right on the list.

See “Changing Properties from a List Window” on page 8-4

� Any property that can be changed for an item in the Job List, can be changed by
selecting the item then selecting the Properties action.

See “Changing Properties using the Properties Window” on page 8-4 

Customizing the Job List Contents
The content of the Job List window List can be customized using the following options
under the View pull-down menu:

Sort by  allows you to sort one or more columns. You can also sort a column by
double-clicking on the column heading.

Include  allows you to specify which Jobs you want to include in the Job List. You can
specify job names, users, job numbers, job types, active jobs, jobs on job queues, com-
pleted jobs with printer output, and job queues.

Columns  allows you to specify which columns are included in the Job List. You can
also specify the columns order.
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Customizing the Job List Window
The following methods can be used to change the way the Job List window looks:

Column width:  To change the width of a column:

1. Position the mouse pointer on the column separator line to the right of the column
heading you want to change. A double arrow is displayed when the mouse point is
on the line.

2. Hold down the left mouse button and move the mouse pointer to the left to make
the column narrower and to the right to make it wider. Wider columns will allow
you to see more information in the columns, but will reduce the number of columns
that you can see at the same time on the screen.

Fonts:  To change the fonts used in the Job List window, select the Fonts option from
the Options pull-down menu.

Status bar:  To specify whether or not the Status bar is displayed on the Job List
window, select the Status bar option from the Options pull-down menu.

Tool bar:  To specify whether or not the Tool bar is displayed on the Job List window,
select the Tool bar option from the Options pull-down menu.

Information area:  To specify whether or not the Information area is displayed on the
Job List window, select the Info area option from the Options pull-down menu.

For details of saving the layout of System Object Access list panels, refer to “Saving
System Object Access Customization” on page 8-18.

Working with Printed Output for a Job
To display a list of the printed output for a job that is included on the Job List:

1. Select the job item you want to change.

Click on the item with the left mouse button, or move the cursor up or down to
highlight the item.

2. Press the right mouse button and select the Printer output action, or click on the
Printer output icon on the tool bar.

This will display the Printer Output List window for that job.

For more details on working with printer output see “Printer Output” on page 8-2.

Displaying a Job Log for a Job
To display the Job Log window for a job:

1. Select the job item you want to display.

Click on the item with the left mouse button, or move the cursor up or down to
highlight the item.

2. Press the right mouse button and select the Job log action.
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For more details on working with job logs see “Job Log” on page 8-16.

 Printers
The Printers function of System Object Access allows you to view and manipulate
printers on the AS/400 system.

Subtopics:

� “Working with the Printer List”
� “Changing Printer Properties” on page 8-13
� “Displaying Printer Output for Printer Entries” on page 8-13
� “Changing the Contents of the Printer List” on page 8-13
� “Customizing the Printer List Window” on page 8-13

Working with the Printer List
Selecting the Printers icon displays a window which lists the printers on the selected
AS/400 system.

To perform an action against one or more items in the list:

1. Select the item or items to perform the action on.

 Hint 

Click with the left mouse button to select a single item. Use the Shift key + the
left mouse button to select a block of items, or use the Ctrl key + the left
mouse to select multiple items that are not listed together.

2. Select the action to perform using one of the following methods:

� Press the right mouse button to display a pop-up menu, then select the action
item.

� Select File from the menu bar and then select the desired action.

� Select the tool bar icon that represents the action you want to perform (not all
actions are available using the tool bar).
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Note:  You can perform the default action for an item in the list by double-clicking on
the item in the Printer List. The default action is the first item on the action
pop-up menu.

For details of saving the layout of System Object Access list panels, refer to “Saving
System Object Access Customization” on page 8-18.

Changing Printer Properties
There are two different ways to change the properties of an item on the Printer List:

� If the property you want to change appears as one of the column headings on the
Printer List, you can change the property right on the list.

See “Changing Properties from a List Window” on page 8-4

� Any property that can be changed for an item in the Printer List, can be changed
by selecting the item then selecting the Properties action.

See “Changing Properties using the Properties Window” on page 8-4 

Displaying Printer Output for Printer Entries
To display the printer output for a specific printer:

1. Double-click on a Printer List entry.

You can also highlight an entry in the Printer List, then select Printer Output from the
File pull-down menu.

Changing the Contents of the Printer List
The content of the Printer List window List can be customized using the following
options under the View pull-down menu:

 � Sort by
 � Include
 � Columns

Sort by  allows you to sort Printer List entries by one or more columns. You can also
sort columns by double-clicking on the column heading.

Include  allows you to specify the printers to include on the Printer List.

Columns  allows you to specify which columns are included in the Printer Output List.

Customizing the Printer List Window
The following methods can be used to change the way the Printer List window looks:

Column width:  To change the width of a column:

1. Position the mouse pointer on the column separator line to the right of the column
heading you want to change. A double arrow is displayed when the mouse point is
on the line.
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2. Hold down the left mouse button and move the mouse pointer to the left to make
the column narrower and to the right to make it wider. Wider columns will allow
you to see more information in the columns, but will reduce the number of columns
that you can see at the same time on the screen.

Fonts:  To change the fonts used in the Printer List window, select the Fonts option
from the Options pull-down menu.

Status bar:  To specify whether or not the Status bar is displayed on the Printer List
window, select the Status bar option from the Options pull-down menu.

Tool bar:  To specify whether or not the Tool bar is displayed on the Printer List
window, select the Tool bar option from the Options pull-down menu.

Information area:  To specify whether or not the Information area is displayed on the
Printer List window, select the Info area option from the Options pull-down menu.

For details of saving the layout of System Object Access list panels, refer to “Saving
System Object Access Customization” on page 8-18.

 Messages
The Messages function of System Object Access allows you to view and manipulate
messages on the AS/400 system.

Subtopics:

� “Working with the Message List”
� “Displaying Message Properties” on page 8-15
� “Changing the Contents of the Message List” on page 8-15
� “Customizing the Message List Window” on page 8-16

Working with the Message List
Selecting the Messages icon displays a window which lists the messages on the
selected AS/400.
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To perform an action against one or more items in the list:

1. Select the item or items to perform the action on.

 Hint 

Click with the left mouse button to select a single item. Use the Shift key + the
left mouse button to select a block of items, or use the Ctrl key + the left
mouse to select multiple items that are not listed together.

2. Select the action to perform using one of the following methods:

� Press the right mouse button to display a pop-up menu, then select the action
item.

� Select File from the menu bar and then select the desired action.

� Select the tool bar icon that represents the action you want to perform (not all
actions are available using the tool bar).

Note:  You can perform the default action for an item in the list by double-clicking on
the item in the Message List. The default action is the first item on the action
pop-up menu.

For details of saving the layout of System Object Access list panels, refer to “Saving
System Object Access Customization” on page 8-18.

Displaying Message Properties
To display message properties:

1. Click on the desired message in the message list or use the cursor up or down
arrow to select a message.

2. Press the right mouse button and select Properties from the pop-up menu, or click
on the Properties icon.

3. Initially, only the basic properties are shown on the Properties window. Select the
Advanced button to display all of the message properties.

For details of the message properties refer to the System Object Access online help
information.

Note:  None of the message properties can be changed.

Changing the Contents of the Message List
The content of the Message List window can be customized using the following options
under the View pull-down menu:

Include  allows you to specify which messages you want to include in the Message List
window based on who the message is for and the message severity.

Columns  allows you to specify which columns are included in the Message List window
as well as the order in which the columns appear.
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Customizing the Message List Window
The following methods can be used to change the way the Message List window looks:

Column width:  To change the width of a column:

1. Position the mouse pointer on the column separator line to the right of the column
heading you want to change. A double arrow is displayed when the mouse point is
on the line.

2. Hold down the left mouse button and move the mouse pointer to the left to make
the column narrower and to the right to make it wider. Wider columns will allow
you to see more information in the columns, but will reduce the number of columns
that you can see at the same time on the screen.

Fonts:  To change the fonts used in the Message List window, select the Fonts option
from the Options pull-down menu.

Status bar:  To specify whether or not the Status bar is displayed on the Message List
window, select the Status bar option from the Options pull-down menu.

Tool bar:  To specify whether or not the Tool bar is displayed on the Message List
window, select the Tool bar option from the Options pull-down menu.

Information area:  To specify whether or not the Information area is displayed on the
Message List window, select the Info area option from the Options pull-down menu.

For details of saving the layout of System Object Access list panels, refer to “Saving
System Object Access Customization” on page 8-18.

 Job Log
The Job Log function of System Object Access allows you to display the job log that
relates to the System Object Access activity.

Details for a message can be displayed by any of the following methods:

� Double-clicking on an entry
� Selecting the Open icon on the tool bar
� Selecting Message details from the File pull-down menu

Subtopics:

� “Changing the Contents of the Job Log Window” on page 8-17
� “Customizing the Job Log Window” on page 8-17
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Changing the Contents of the Job Log Window
The content of the Job Log window can be customized using the following options
under the View pull-down menu:

Columns  allows you to specify which columns are included in Job Log window as well
as the order in which the columns appear.

Customizing the Job Log Window
The following methods can be used to change the way the Job Log window looks:

Column width:  To change the width of a column:

1. Position the mouse pointer on the column separator line to the right of the column
heading you want to change. A double arrow is displayed when the mouse point is
on the line.

2. Hold down the left mouse button and move the mouse pointer to the left to make
the column narrower and to the right to make it wider. Wider columns will allow
you to see more information in the columns, but will reduce the number of columns
that you can see at the same time on the screen.

Fonts:  To change the fonts used in the Job Log window, select the Fonts option from
the Options pull-down menu.

Status bar:  To specify whether or not the Status bar is displayed on the Job Log
window, select the Status bar option from the Options pull-down menu.

Tool bar:  To specify whether or not the Tool bar is displayed on the Job Log window,
select the Tool bar option from the Options pull-down menu.

Information area:  To specify whether or not the Information area is displayed on the
Job Log window, select the Info area option from the Options pull-down menu.

For details of saving the layout of System Object Access list panels, refer to “Saving
System Object Access Customization” on page 8-18.
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Saving System Object Access Customization
When you exit, certain customization information is automatically saved to your work-
station in the PCS.INI file in your CAWIN directory. When you sign on again at that
workstation your windows should look the same.

Information that is saved includes:

� Include criteria for a list
� Column information for a list

 � Font changes
� Whether the tool bar, status bar, and information area are displayed
� All column sizes

 � Window size
� Window location on the desktop

To save your customization data immediately:

1. Select File from the menu bar.
2. Select Save view from the pull-down menu.
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Chapter 9. Using the Host Command Interface

The host command interface allows you to enter AS/400 commands from the PC. To
open a host command prompt, double-click on the Host Command icon in the Client
Access/400 for Windows 3.1 group window.
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 Chapter 10. Coexistence Considerations

This section describes coexistence considerations when using Client Access/400 for
Windows 3.1

Subtopics:

� “Using the Reflector Interface”
� “Using the ODBC Driver with Other Clients” on page 10-4

Using the Reflector Interface
Client Access/400 for Windows 3.1 includes a DOS Reflector capability that accepts
calls to the Base DOS Client Access/400 or base DOS Client Access/400 router API
and passes them on to the Windows based router used by Client Access/400 for
Windows 3.1. This capability allows you to run applications that were written to the
Base DOS router API in a DOS session under Client Access/400 for Windows 3.1
without modification. The API must be called through the reflector interface main
program level (from a program level); the API should not be called from the interrupt
level.

Some of the functions included with Base DOS Client Access/400 and Base DOS Client
Access/400 also use only the router API, and it is possible to run them with the
Windows client. This coexistence does not require the DOS router to be loaded before
Windows is started because the Client Access/400 for Windows 3.1 router is used.

Notes:

1. Only the Base DOS client is supported with the reflector interface. It is not pos-
sible to run the DOS with Extended Memory client functions with Client Access/400
for Windows 3.1 because the DOS Extender (PCSXI) is required and the DOS
Extender does not run in the Windows environment.

2. Work station function is not supported with Client Access/400 for Windows 3.1.

For information about using the Base DOS client functions, see Client Access/400 for
DOS User Guide. The Base DOS client functions that can be used with Client
Access/400 for Windows 3.1 include the following:

� File Transfer (RFROMPC, RTOPC, RFROMPCB, RTOPCB)
� Remote Command (RMTCMD)

 � Message Function
 � Update Function

Subtopics:

� “General Considerations for Using the Reflector Interface” on page 10-2
� “File Transfer” on page 10-3
� “Remote Command” on page 10-3
� “Message Function” on page 10-3
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� “Update Function” on page 10-3

General Considerations for Using the Reflector Interface
If you intend to use Base DOS client functions from the standard Client Access/400 or
Client Access/400 group using the reflector interface, you need to do the following:

1. Edit the batch files provided to set the value of the environment variable EHNP.
This ensures that commands are run from the local PC disk rather than the
AS/400. The following example displays the Remote Command icon with the
change highlighted.

@REM WARNING: DO NOT MODIFY THIS FILE
  ECHO OFF
  C:
  SET EHNP=C:\PCS
  CD %EHNP%

IF EXIST %EHNP%\RMTCMD.EXE GOTO LOCAL
IF NOT EXIST I:\QIWSFLR\RMTCMD.EXE GOTO ERROR
I:\QIWSFLR\RMTCMD.EXE %1 %2 %3 %4 %5 %6 %7 %8 %9 /Z

  GOTO EXIT
  :ERROR
  ECHO I:\QIWSFLR\RMTCMD.EXE
  I:\QIWSFLR\RMTCMD.EXE
  :PAUSE
  GOTO EXIT
  :LOCAL

%EHNP%\RMTCMD.EXE %1 %2 %3 %4 %5 %6 %7 %8 %9 /Z
  :EXIT
  PAUSE

2. Ensure that you have the I: drive assigned to the QDLS file system using Client
Access/400 for Windows 3.1. This allows commands to be run from the AS/400 if
they are not present in the PCS directory. To copy the code to the PCS directory,
use the Base DOS Client Access/400 configuration program.

3. Delete any unwanted or unsupported icons from the Client Access/400 or DOS
Client Access/400 group, such as the “Administration” and “Folders” icons.

Note:  You may also like to delete icons such as “Client Access Startup” and
“AS/400 Connection” to save confusion. They simply call the equivalent Client
Access/400 for Windows 3.1 functions.
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 Hint 

If you want to run the full Client Access/400 or DOS Client Access/400 including the
DOS router after installing Client Access/400 for Windows 3.1, you have to remove
the following line from the Enh386 section of SYSTEM.INI file:

[Enh386]
DEVICE=C:\CAWIN\VREFLECT.386

Failure to do this will result in the following error:

5ð42 - Client Access/4ðð router has not been started

 File Transfer
You can convert file transfer definitions into the format used by the Client Access/400
for Windows 3.1 RUMBA/400 file transfer. However, if you need to continue to use a
DOS batch file approach for file transfers, you can continue to use the batch interface
supplied with Base DOS Client Access/400 together with the interactive interface used
to define file transfer requests.

For example, if you have a file transfer request called TESTTFR.TTO and you have the
Client Access/400 for Windows 3.1 router started to the AS/400, you could enter the
following in a DOS session. To do this, you need to copy the file transfer code to the
PC):

C:\PCS\RTOPCB C:\PCS\TESTTFR.TTO

This automatically recalls and runs the transfer request using the Client Access/400 for
Windows 3.1 router.

 Remote Command
Client Access/400 for Windows 3.1 maintains the Remote Command API that is avail-
able with the DOS clients. The Remote Command function provided with the Base
DOS clients can be used in a DOS session with Client Access/400 for Windows 3.1
provided that Client Access/400 for Windows 3.1 has an active router connection to the
AS/400 system.

 Message Function
Although it is possible to use the message function from Client Access/400 or DOS
Client Access/400 client using the DOS Reflector interface, there is no message func-
tion included in Client Access/400 for Windows 3.1.

 Update Function
You should use the Application Update Function that is supplied with Client Access/400
for Windows 3.1. Using the Base DOS client Update Function is not recommended.
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Using the ODBC Driver with Other Clients
The following instructions allow the ODBC driver packaged with Client Access/400 for
Windows 3.1 to be used with DOS with Extended Memory or most competing clients,
such as, NetWare for SAA**. These instructions DO NOT apply to the Client
Access/400 for Windows 3.1 client.

 Notice 

These instructions have not been fully tested and are not officially supported.

Prerequisites:

� For All users:

� Product 5763-XC1 must be installed on the V3R1 AS/400.

� Cumulative PTF package 5070 (or later) must be applied on the system after
5763-XC1 is installed.

� Programming temporary fixes (PTFs) SF22711 for 5763-XC1 and SF22323 for
5763-SS1 or later must be installed.

� For OS/2 users:

� OS/2 must be at version 2.11 (or later) or Warp version 3. Use the SYSLEVEL
command to find out what version you are using.

� Communications Manager/2 (if used) must be at version 1.11 or later (SYSLEVEL
will also show this).

� DOS VDM (virtual DOS machine) settings should be set as described in the Inter-
national Technical Support Center redbook Using V2R3 DOS and OS/2 PC
Support/400 under OS/2 2.1, GG24-4070.

� Both OS/2 and DOS with Extended Memory clients must be at the R310 system
PTF level. To determine this, look at the first line in the QPTFIDX file in the PCS
or PCSOS2 directory.

� You must use STARTPCS.BAT for the virtual DOS machine (VDM) and the envi-
ronment variables EHNP and EHNL must be set correctly (see below for details).

To manually install the ODBC driver:

1. You will need to manually copy several files to a shared folder in QDLS so that you
can copy the files to the PC. To do this, you must use the CPY command (not the
PC copy command) at the AS/400 command line prompt. Note that the x's and y's
below should be substituted by a directory name that you supply. Type the fol-
lowing commands at the AS/400 command line:
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 MD '/qdls/xxxxxxxx'
 MD '/qdls/xxxxxxxx/mri2924'
 MD '/qdls/yyyyyyyy'
 MD '/qdls/yyyyyyyy/system'

CPY OBJ('/qpwxcwn/ehnodbc3.dll') TODIR('/qdls/xxxxxxxx')
CPY OBJ('/qpwxcwn/ehnstp3.dll') TODIR('/qdls/xxxxxxxx')
CPY OBJ('/qpwxcwn/mri2924/ehnodbc3.\') TODIR('/qdls/mri2924/xxxxxxxx')
CPY OBJ('/qpwxcwn/ctl3d.dll') TODIR('/qdls/yyyyyyyy/system')
CPY OBJ('/qpwxcwn/odbc.dll') TODIR('/qdls/yyyyyyyy/system')
CPY OBJ('/qpwxcwn/odbcadm.exe') TODIR('/qdls/yyyyyyyy')
CPY OBJ('/qpwxcwn/odbcadm.hlp') TODIR('/qdls/yyyyyyyy')
CPY OBJ('/qpwxcwn/odbcinst.dll') TODIR('/qdls/yyyyyyyy')

 Hint 

If you are using NetWare for SAA** to access the AS/400, you may need to
copy some additional files to the PC. Some of the supplied files that come with
NetWare (EHN*.DLL) may be out of date. To copy the additional files:

CPY OBJ('/qpwxcwn/ehn\.dll') TODIR('/qdls/yyyyyyyy/system')

2. Copy the files from the shared folders you created in step 1 to the corresponding
directories on the PC. Before copying the files into these directories, you should
check to see if these files exist and make backup copies if they do exist. NetWare
users should backup the EHN*.DLL files in the WINDOWS\SYSTEM directory. To
copy the files to the PC type the following command at the PC prompt:

XCOPY I:/xxxxxxxx/\.\ /S C:/PCS
XCOPY I:/yyyyyyyy/\.\ /S C:/WINDOWS

Note:  For WINOS2 users, substitute C:/OS2/MDOS/WINOS2 for C:/WINDOWS
for this and subsequent steps.

3. Add the following entries to the ODBCINST.INI file located in the WINDOWS direc-
tory.

� Under Client Access/400 ODBC Driver  add the following entries:

 Driver=C:/PCS/EHNODBC3.DLL
 Setup=C:/PCS/EHNSTP3.DLL

� Under ODBC Drivers  add the following entries:

AS/4ðð PC Support ODBC Driver=Installed
Client Access/4ðð Driver=Installed
Access Data (\.mdb)=Installed

4. Edit the WIN.INI file located in the WINDOWS directory and add the following at
the end of the file:

 [CAWIN]
 EHNP=C:/PCS
 EHNL=2924

5. Edit the AUTOEXEC.BAT file and add the following lines to the top of the file. This
is done automatically if you are using STARTPCS.BAT.

 SET EHNP=C:/PCS
 SET EHNL=2924
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6. Start Windows and add a new program item to the Client Access program group.
To add a new program item, select the New option from the File pull-down menu
on the Program Manager group window. Use \WINDOWS\ODBCADM.EXE for the
program name and \WINDOWS for the working directory. Name the new program
item ODBC Administration.

7. Double-click on the new ODBC Administration icon you created to add a new data
source that uses the ODBC driver you just installed.

You should now have a working version of the Client Access/400 for Windows 3.1
ODBC driver.
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DSMMOM395I '.EDFPO' LINE 80: .po rzae821
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 248 OF 'RZAE8C02'
DSMMOM397I 'RZAE8C02' WAS IMBEDDED AT LINE 51 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae826
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 364 OF 'RZAE8C02'
DSMMOM397I 'RZAE8C02' WAS IMBEDDED AT LINE 51 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae808
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 439 OF 'RZAE8C02'
DSMMOM397I 'RZAE8C02' WAS IMBEDDED AT LINE 51 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae809
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 446 OF 'RZAE8C02'
DSMMOM397I 'RZAE8C02' WAS IMBEDDED AT LINE 51 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae810
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 602 OF 'RZAE8C02'
DSMMOM397I 'RZAE8C02' WAS IMBEDDED AT LINE 51 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae811
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 629 OF 'RZAE8C02'



DSMMOM397I 'RZAE8C02' WAS IMBEDDED AT LINE 51 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae885
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 78 OF 'RZAE8C03'
DSMMOM397I 'RZAE8C03' WAS IMBEDDED AT LINE 54 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae886
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 251 OF 'RZAE8C03'
DSMMOM397I 'RZAE8C03' WAS IMBEDDED AT LINE 54 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae887
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 263 OF 'RZAE8C03'
DSMMOM397I 'RZAE8C03' WAS IMBEDDED AT LINE 54 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae888
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 317 OF 'RZAE8C03'
DSMMOM397I 'RZAE8C03' WAS IMBEDDED AT LINE 54 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae889
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 340 OF 'RZAE8C03'
DSMMOM397I 'RZAE8C03' WAS IMBEDDED AT LINE 54 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae890
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 407 OF 'RZAE8C03'
DSMMOM397I 'RZAE8C03' WAS IMBEDDED AT LINE 54 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae891
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 188 OF 'RZAE8C08'
DSMMOM397I 'RZAE8C08' WAS IMBEDDED AT LINE 69 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae892
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 684 OF 'RZAE8C08'
DSMMOM397I 'RZAE8C08' WAS IMBEDDED AT LINE 69 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae893
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 880 OF 'RZAE8C08'
DSMMOM397I 'RZAE8C08' WAS IMBEDDED AT LINE 69 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE



NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae894
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 1050 OF 'RZAE8C08'
DSMMOM397I 'RZAE8C08' WAS IMBEDDED AT LINE 69 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae895
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 1204 OF 'RZAE8C08'
DSMMOM397I 'RZAE8C08' WAS IMBEDDED AT LINE 69 OF 'RZAE8MST'
DSMBEG323I STARTING PASS 2 OF 3.
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae800
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 57 OF 'RZAE8C02'
DSMMOM397I 'RZAE8C02' WAS IMBEDDED AT LINE 51 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae820
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 227 OF 'RZAE8C02'
DSMMOM397I 'RZAE8C02' WAS IMBEDDED AT LINE 51 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae821
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 248 OF 'RZAE8C02'
DSMMOM397I 'RZAE8C02' WAS IMBEDDED AT LINE 51 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae826
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 364 OF 'RZAE8C02'
DSMMOM397I 'RZAE8C02' WAS IMBEDDED AT LINE 51 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae808
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 439 OF 'RZAE8C02'
DSMMOM397I 'RZAE8C02' WAS IMBEDDED AT LINE 51 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae809
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 446 OF 'RZAE8C02'
DSMMOM397I 'RZAE8C02' WAS IMBEDDED AT LINE 51 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae810
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 602 OF 'RZAE8C02'
DSMMOM397I 'RZAE8C02' WAS IMBEDDED AT LINE 51 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.



DSMMOM395I '.EDFPO' LINE 80: .po rzae811
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 629 OF 'RZAE8C02'
DSMMOM397I 'RZAE8C02' WAS IMBEDDED AT LINE 51 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae885
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 78 OF 'RZAE8C03'
DSMMOM397I 'RZAE8C03' WAS IMBEDDED AT LINE 54 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae886
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 251 OF 'RZAE8C03'
DSMMOM397I 'RZAE8C03' WAS IMBEDDED AT LINE 54 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae887
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 263 OF 'RZAE8C03'
DSMMOM397I 'RZAE8C03' WAS IMBEDDED AT LINE 54 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae888
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 317 OF 'RZAE8C03'
DSMMOM397I 'RZAE8C03' WAS IMBEDDED AT LINE 54 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae889
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 340 OF 'RZAE8C03'
DSMMOM397I 'RZAE8C03' WAS IMBEDDED AT LINE 54 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae890
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 407 OF 'RZAE8C03'
DSMMOM397I 'RZAE8C03' WAS IMBEDDED AT LINE 54 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae891
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 188 OF 'RZAE8C08'
DSMMOM397I 'RZAE8C08' WAS IMBEDDED AT LINE 69 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae892
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 684 OF 'RZAE8C08'
DSMMOM397I 'RZAE8C08' WAS IMBEDDED AT LINE 69 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae893
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'



DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 880 OF 'RZAE8C08'
DSMMOM397I 'RZAE8C08' WAS IMBEDDED AT LINE 69 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae894
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 1050 OF 'RZAE8C08'
DSMMOM397I 'RZAE8C08' WAS IMBEDDED AT LINE 69 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae895
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 1204 OF 'RZAE8C08'
DSMMOM397I 'RZAE8C08' WAS IMBEDDED AT LINE 69 OF 'RZAE8MST'
DSMBEG323I STARTING PASS 3 OF 3.
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae800
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 57 OF 'RZAE8C02'
DSMMOM397I 'RZAE8C02' WAS IMBEDDED AT LINE 51 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae820
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 227 OF 'RZAE8C02'
DSMMOM397I 'RZAE8C02' WAS IMBEDDED AT LINE 51 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae821
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 248 OF 'RZAE8C02'
DSMMOM397I 'RZAE8C02' WAS IMBEDDED AT LINE 51 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae826
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 364 OF 'RZAE8C02'
DSMMOM397I 'RZAE8C02' WAS IMBEDDED AT LINE 51 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae808
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 439 OF 'RZAE8C02'
DSMMOM397I 'RZAE8C02' WAS IMBEDDED AT LINE 51 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae809
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 446 OF 'RZAE8C02'
DSMMOM397I 'RZAE8C02' WAS IMBEDDED AT LINE 51 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae810
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'



DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 602 OF 'RZAE8C02'
DSMMOM397I 'RZAE8C02' WAS IMBEDDED AT LINE 51 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae811
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 629 OF 'RZAE8C02'
DSMMOM397I 'RZAE8C02' WAS IMBEDDED AT LINE 51 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae885
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 78 OF 'RZAE8C03'
DSMMOM397I 'RZAE8C03' WAS IMBEDDED AT LINE 54 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae886
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 251 OF 'RZAE8C03'
DSMMOM397I 'RZAE8C03' WAS IMBEDDED AT LINE 54 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae887
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 263 OF 'RZAE8C03'
DSMMOM397I 'RZAE8C03' WAS IMBEDDED AT LINE 54 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae888
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 317 OF 'RZAE8C03'
DSMMOM397I 'RZAE8C03' WAS IMBEDDED AT LINE 54 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae889
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 340 OF 'RZAE8C03'
DSMMOM397I 'RZAE8C03' WAS IMBEDDED AT LINE 54 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae890
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 407 OF 'RZAE8C03'
DSMMOM397I 'RZAE8C03' WAS IMBEDDED AT LINE 54 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae891
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 188 OF 'RZAE8C08'
DSMMOM397I 'RZAE8C08' WAS IMBEDDED AT LINE 69 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae892
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 684 OF 'RZAE8C08'
DSMMOM397I 'RZAE8C08' WAS IMBEDDED AT LINE 69 OF 'RZAE8MST'



DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae893
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 880 OF 'RZAE8C08'
DSMMOM397I 'RZAE8C08' WAS IMBEDDED AT LINE 69 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae894
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 1050 OF 'RZAE8C08'
DSMMOM397I 'RZAE8C08' WAS IMBEDDED AT LINE 69 OF 'RZAE8MST'
DSMKPO660W POSTSCRIPT FILE'S LINE LENGTH VIOLATES ADOBE STRUCTURING CONVE
NTIONS.
DSMMOM395I '.EDFPO' LINE 80: .po rzae895
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 80 OF '.EDFPO'
DSMMOM397I '.EDFPO' WAS IMBEDDED AT LINE 910 OF '.EDFAWRK'
DSMMOM397I '.EDFAWRK' WAS IMBEDDED AT LINE 1204 OF 'RZAE8C08'
DSMMOM397I 'RZAE8C08' WAS IMBEDDED AT LINE 69 OF 'RZAE8MST'


